




OL Connect (Enterprise Edition)

Installation and Activation Guide

Version 2023.2.1

Last Revision: 2024-06-11

All trademarks displayed are the property of their respective owners.

© Upland Software, Inc. Inc. 1994-2024. All rights reserved. No part of this documentation

may be reproduced, transmitted or distributed outside of Upland Software, Inc. by any

means whatsoever without the express written permission of Upland Software, Inc.. Upland

Software, Inc. disclaims responsibility for any errors and omissions in this documentation

and accepts no responsibility for damages arising from such inconsistencies or their further

consequences of any kind. Upland Software, Inc. reserves the right to alter the information

contained in this documentation without notice.



Table of Contents
System and hardware considerations 7

Antivirus Exclusions 7
Directories and folders 7

Database Considerations 9
Using the MariaDB Instance from the Installer 9

Installing Connect using an existing MySQL instance 9

Installing Connect using an existing Microsoft SQL Server instance 10

When modifying Connect 11

Environment considerations 12
Remote Desktop Support 12

Antivirus Considerations 12

Windows Search Indexing Service 12

Commandline switches and .ini entries 13

Language and Encoding Considerations 13

Network considerations 14
Firewall/Port considerations 14

Performance considerations 15
Performance analysis details 15

Engine configuration 16

Template optimization 17

Network and internet connections 17

Hardware configuration 17

System requirements 18
Operating system 18

Supported virtual environments 18

Recommended system requirements for the OL Connect / Workflow servers 18

A word of caution 19

Rules of thumb 19

Installation and Activation 20

Where to obtain the installers 20

Installation prerequisites 21

User accounts and security 21
Windows user account 21

OL Connect Server user accounts 22

Installing OL Connect on machines without internet access 23
Updating Connect 23

Initial Connect Installation 23

Installation Wizard 24
Updating from Connect versions predating 2019.1 24

Starting the OL Connect installer 24

Prerequisites Installation 25

Page 4



Welcome screen 25

License Agreement 25

Component Selection 26

OL Connect Service Configuration 28

OL Connect Server Connection 29

Database Configuration 30

Configuring External Database Connection 31

Ready to install 33

Installation Finished 33

The Product Update Manager 33

Product Activation 34

Running Connect installer in Silent Mode 34
Updating from Connect versions predating 2019.1 34

General information 34

Installation Properties file 34

Properties file examples 40

Exit Codes 41

Activating a License 43
Obtaining the OL Connect Magic Number 43

Requesting a license 44

Activating OL Connect Workflow 45

Activating OL Connect 45

Reactivating your license 45

Migrating to a new workstation 46
Before installing the software 46

Downloading and installing the software 46

Backing up files from the current workstation 47

Secondary software and licenses 50

Configuring OL Connect 51

Uninstalling OL Connect from the previous workstation 53

Upgrading 53
Upgrading from previous Connect versions 54

Upgrading from PReS Classic 60

Upgrading from PlanetPress Suite 6/7 60

Information about OL ConnectWorkflow 77

Server configuration settings 79

Connection preferences 80
Background 80

Connection settings (standalone/Master) 80

Connection settings (Client) 82

Security and Users Settings 83

Engine configuration 84
Speed quota: Pages Per Minute 86

Launching multiple engines 87

Page 5



Allocating processing power to jobs 89

Automatic Restart settings 92

Parallel Processing preferences 93
Parallel Processing properties (Designer Preferences) 93

Parallel Processing properties (Server Configuration) 95

Server Clustering 100
Quick Howto 101

Clustering Preferences and Setup 103

Known Issues 104

Additional Content font selection issue 104

Errors running OL Connect database cleanup 104

Space in data field name can cause incorrect barcode 105

Editing in Preview mode breaks translation feature 105

Absolute positioned boxes cannot be moved 105

Translation issue 105

Unicode Variation Selectors issue 105

Font names containing 'undefined' characters 106

ODBC drivers do not all work with OL Connect 106

Incorrect colors in print preview 106

Concatenating PDF files is slower 106

Account permission issues 106

Expressions not supported in HTML attributes 106

Master Page not affected by style rules for <body> 107
Line and Bar charts 113

Uninstalling 119

Legal Notices and Acknowledgments 121

Page 6



System and hardware considerations
There are a variety of considerations to be aware of. These are documented in the following

pages:

l "System requirements" on page 18

l "Database Considerations" on page 9

l "Environment considerations" on page 12

l "Known Issues" on page 104

l "Language and Encoding Considerations" on page 13

l "Antivirus Exclusions" below

l "Performance considerations" on page 15

Antivirus Exclusions
The information on this page is designed to assist IT managers and IT professionals decide

what anti-virus strategy to follow with consideration to OL Connect and their internal

requirements and needs. This page describes the mode of operation and the files and

folders used by OL Connect as well as the files, folders and executables that are recom-

mended to be ignored for best possible performance and to avoid issues caused by anti-

virus file locks.

IT managers and IT professionals then may decide the anti-virus strategy to follow for their

internal requirements and needs depending on the statements outlined herein.

Directories and folders
All Connect applications are installed under an arbitrarily selectable main folder. If the

default installation folder options were used, this installation folder would be

"%PROGRAMFILES%\Objectif Lune\OL Connect".

The installation folder will hold all the executable files and other files and folders required

for the operation of the whole product suite. All these files and folders remain static after

installation. It depends upon the company virus protection strategy, if such files and folders

will be monitored or not.

We do, however, recommend that the following file or folders be excluded from antivirus pro-

tection.

Connect Service

The Connect Service is run via the executable file ServerService.exe. This file has been

reported as causing issues with some antivirus packages, so we recommend adding this file
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to the antivirus exclusion list, if possible.

The executable will be installed to the installation target "Connect Server" sub-folder. The

full installation folder can be found by entering "%PROGRAMFILES%\Objectif Lune\OL Con-

nect\Connect Server" in Windows Explorer.

AFP Input (Enterprise edition only)

Performance issues have been reported with the AFP Input option under Windows Server

versions from Windows Server 2012 onwards. The issues have been specifically associated

with Windows Servers running Windows Defender, but the performance degradation might

also be encountered when using other Antivirus applications.

Consequently, we recommend that an exclusion be made for the afp2pdf.exe executable

file in your Antivirus application.

The afp2pdf.exe file is stored in a subfolder under the installation folder. If the exact install-

ation folder name is required, enter the standardized system variable %PROGRAMFILES% in

Windows Explorer and then search for afp2pdf.exe.

Working folders

Working folders for Connect are created and used on a per-user-basis under the respective

user's profile folder, accessible on Windows with the standardized system variable

%USERPROFILE% in the subfolder "Connect". Working folders are:

l "%USERPROFILE%\Connect\filestore": This folder will hold non-intermediate files for

the operation of Connect. Files in this folder will be used frequently, but not with a high

frequency. Supervising this folder with a virus protection system should not have too

much of an impact on the speed of the whole Connect suite.

l "%USERPROFILE%\Connect\logs": As the name implies, log files are created and

updated here. These log files are plain text files. Virus protection may have an impact

on the speed of the whole Connect suite.

l "%USERPROFILE%\Connect\temp": Storage folder for temporary data, usually inter-

mittent files in multiple folders. Virus protection on this folder and its subfolders may

have a serious impact on the performance of Connect.

l "%USERPROFILE%\Connect\workspace": Usually containing settings and helper files

and folders. Supervising this folder with a virus protection system should not have too

much of an impact on the speed of the whole Connect suite.
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Database 1

Depending on the components installed, a database instance is created in a folder called

"connect.database" under the Windows system temp folder. This folder is accessible via the

standardized system variable %TMP%. Usually, folders holding such temporary files and

folders should be excluded from a virus protection, because this influences the overall per-

formance of the whole system at all. However the responsible person for the computer pro-

tection has to decide about the monitoring of such temporary folders following the

company guidelines.

Database 2

Another database instance for Connect will be hold and used under the folder, which is

intended to hold data, accessible by and for all users. The path to this folder is stored in the

standardized system variable %PROGRAMDATA%. The Connect database instance is located in

the subfolder "Objectif Lune\OL Connect\MariaDB".

As this database will be in extremely strong usage, virus protection on this folder and its

sub-folders may have a serious impact on the performance of Connect.

Database Considerations
This page describes the different considerations and pre-requisites for the database back-

end used by OL Connect, whether using the MariaDB instance provided by the installer, or

pre-existing (external) instance.

Using the MariaDB Instance from the Installer
The MariaDB Instance provided in the "Installation Wizard" on page 24 is already pre-con-

figured with options to provide the most stable back-end setup.

Installing Connect using an existing MySQL instance
If MySQL Server is already present and you wish to use it, the following should be taken into

consideration:

l The minimum supported MySQL version is MySQL 5.6.

l The MySQL account must have access to all permissions using the GRANT Command,

including creating databases.

l The database configuration must include the following options:

l max_connections = 200 : OL Connect uses a lot of database connections. This

number ensures that even in high volume environments, enough connections will

be available.
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l max_allowed_packet = 500M : In some implementations, especially when using

Capture OnTheGo, large packet sizes are required to allow transferring binary

files. This substantial packet size maximum setting ensures that the data

received by OL Connect will be able to be stored within the database.

l character-set-server = utf8 , collation-server = utf8_unicode_ci , default-char-

acter-set=utf8 : These indicate database support for UTF-8/Unicode.

l The database configuration must allow the use of mixed case table names.

This is particularly an issue on Linux MySQL installations.

l The SQL instance must be open to access from other computers. This means the bind-

address option should not be set to 127.0.0.1 or localhost.

Caution: If you chose not to install the supplied MariaDB database, and instead opt

for using a pre-existing (External) database then you yourself must ensure that the

External database is accessible to Connect.

Upland Software, Inc. will take no responsibility for setting up database connections to

any but the supplied MariaDB database.

See "Database Considerations" on the previous page for more information about set-

ting up external databases.  

Options available within the installer:

l The Configuration page for the local MySQL is displayed.

l MySQL settings are pre-filled with default values if no existing MySQL database con-

figuration is found.

l MySQL settings are pre-filled with existing database configuration settings, if they

point to a MySQL database type.

Installing Connect using an existing Microsoft SQL Server instance
If Microsoft SQL Server is already present and you wish to use it, the following should be

taken into consideration:

Caution: If you chose not to install the supplied MariaDB database, and instead opt

for using a pre-existing (External) database then you yourself must ensure that the

External database is accessible to Connect.

Upland Software, Inc. will take no responsibility for setting up database connections to
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any but the supplied MariaDB database.

See "Database Considerations" on page 9 for more information about setting up

external databases.

Note: Since OL Connect version 1.6 the minimum required version of the MS SQL

Server is SQL Server 2012.

l When MS SQL is selected, the default values for root user are sa and 1433 for the port.

l If database settings from a previous OL Connect installation are found, the pre-

exising settings will be displayed for the matching database type. For MS SQL set-

tings, this will only work if they were created with Server Config Tool 1.5.0 or later, or

the Installer for OL Connect 1.6.0 or later.

If the database type is changed in the Installer configuration page, the default values

for this database type will be displayed.

If the pre-existing database settings are set to Hsqldb, the default database type

selection will be MySQL.

l Selected database settings are stored in the preferences, and can be found in this file:

C:\ProgramData\Objectif Lune\OL Con-

nect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.prefs

When modifying Connect
l If the local MariaDB is removed from an installation, the Database Configuration page

will offer additionally the Microsoft SQL Server database type with respective default

values.

l If local MariaDB is added to an installation, the usual MariaDB Configuration page

with default values will be displayed.

If the user has installed the Installer Supplied MySQL (2021.2 or earlier) or MariaDB (2022.1

and later) and then switches to an external Microsoft SQL by using the Server Con-

figuration Tool, the supplied local database cannot be switched off. By design the installer

adds a service dependency between Connect Server and the supplied MariaDB \ MySQL ser-

vice.

Page 11



To remove this dependency the user needs to do the following

1. Have a foreign Microsoft SQL running, ready for use with Connect Server.

2. Use the Server Configuration Tool Database Connection preferences to switch the

database to Microsoft SQL.

3. Re-start the Connect Server Service, so that the modifications become active.

4. Counter check that everything is working properly with Microsoft SQL.

5. Open a command-line prompt with full administration rights.

6. Enter the command sc config OLConnect_Server depend= /. This removes the

dependency.

Please be aware: The key word depend must be followed immediately by the equal

sign, but between the equal sign and the forward slash there must be a space.

Additional information can be found here: http://serverfault.com/questions/24821.

7. After the dependency has been removed, it is possible to stop the supplied MariaDB \

MySQL service (OLConnect_MySQL).

Environment considerations
Remote Desktop Support
Tests have demonstrated that OL Connect can be used through Remote Desktop. It is how-

ever possible that certain combination of OS could cause issues. If problems are

encountered, please contact OL Support and we will investigate.

OL Connect 1.3 and later have been certified under Remote Desktop.

Antivirus Considerations
l Antivirus software may slow down processing or cause issues if they are scanning in

temporary folders or those used by OL Connect. Please see "Antivirus Exclusions" on

page 7 for more information.

l Antivirus software might interfere with installation scripts, notably a VBS script to

install fonts. McAfee, in particular, should be disabled temporarily during installation

in order for MICR fonts to install and the installation to complete successfully.

Windows Search Indexing Service
Tests have concluded that the Windows Search service, used to provide indexing for Win-

dows Search, can interfere with Connect when installing on a virtual machine. If the install-

ation hangs during the last steps, it is necessary to completely disable this service during

installation.
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l Click on Start, Run.

l Type in services.msc and click OK.

l Locate the Windows Search service and double-click on it.

l Change the Startup Type to Disable, and click Stop to stop the service.

l Try the installation again.

l Once complete, you may re-enable the service and start it.

Commandline switches and .ini entries
OL Connect is intended to work stably and reliably, based on Java and the Eclipse frame-

work. To ensure this reliability and robustness, many Java and Eclipse parameters have

been tested and tuned, which is reflected in the respective .ini entries and the used com-

mand line switches. A collection of valuable settings has been elaborated and found its

entry in OL Connect “good switches list” (called the “whitelist”).

The protection of the end user’s system is one of our main goals and therefore we have

implemented a very strict verification mechanism, which ensures, that only these whitel-

isted ini entries and command-line switches are accepted, when one of Connect com-

ponents is started and run. Please be therefore advised, that any non-whitelisted ini entry

or command-line switch will be accepted and will - if tried to be used - lead to the respect-

ive application’s “sudden death”. If you should encounter such a behavior then please

double-check your Connect log file/s for respective entries.

Language and Encoding Considerations
Please note the following considerations:

l Language:

OL Connect is currently offered in several languages. You can switch between these

languages via the Preferences dialog. The current languages include:

l English

l French

l German

l Spanish

l Italian

l Korean

l Portuguese
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l Chinese (Simplified)

l Chinese (Traditional)

l Japanese.

The default language is English.

The OL Connect help system (this document and the online help) is currently only

available in English and (for the biggest part) in French.

l Encoding:

Issues can sometimes be encountered in menus and templates when running OL Con-

nect on a non-English operating system. These are due to encoding issues and will be

addressed in a later release.

Network considerations
The following should be taken into consideration in regards to network settings and com-

munications.

l If a local proxy is configured (in the Internet Explorer Options dialog), the option

Bypass proxy server for local addresses must be checked, or some features depend-

ing on local communication will not work.

Firewall/Port considerations
The following describes all of the ports that can be used by an OL Connect solution. IT staff

may decide the firewall strategy to follow for their internal requirements and needs depend-

ing on the statements outlined herein.

Listens on

port #

Destination port

#
Type Comment

Messenger 5863/5864 5863/5864 TCP+UDP Used for inter-module communication

Connect Server 9340 TCP Used for Connect REST API

Connect Server 9350 TCP
Dedicated internal connection for inter-pro-
cess communication (i.e. between engines)

HTTP Server 8080 TCP

HTTPS Server 443 TCP

NodeJS Server 9090 TCP

NodeJS HTTPS Server 8443 TCP

SMTP Input plugin
25, or 587 when encryp-
tion is enabled

TCP

Email Input plugin 110 TCP Default POP3 port
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Listens on

port #

Destination port

#
Type Comment

Secure Email Input plugin 993 TCP

Send Email plugin 25 TCP Default SMTP port

Secure Email Output plugin 587 TCP

LPR 515 TCP

LPD 515 TCP

Telnet 9100 TCP

FTP Input/Output 21 TCP

MariaDB/MySQL 3306 TCP+UDP

Microsoft SQL Server 1433 TCP+UDP

HyperSQL 9001 TCP

l Port numbers in bold type are user configurable.

l Port numbers in bold underlined type are based on the type of database used.

l Some of the ports listed above may also be used by other modules.

l User-configurable modules may use other ports entirely, depending on the settings

defined by the end user. A few examples:

The Create Email Content plugin will use the port defined in the Mail host setting in

Workflow's OL Connect Preferences.

The ports used by the HTTP Client Input task, Legacy SOAP Client and SOAP Client

plugin depend on the configured URL.

Performance considerations
In order to get the most out of OL Connect, it is important to determine how best to max-

imize performance. The following guidelines will be helpful in extracting the best per-

formance from OL Connect and they give a rough indication when it would be useful to

start looking into hardware upgrades.

Performance analysis details
OL Connect's output speed is limited to a certain number of output items (web pages,

emails, or printed pages) per minute. What the maximum total output speed will be is

determined by your license (see "Speed quota: Pages Per Minute" on page 86).

To get an indication of the actual Print output speed, output a Print template to a AFP

(Enterprise edition only), PDF or PS file, using one single Weaver engine and the maximum

target speed per job (see "Parallel Processing preferences" on page 93).

Next, open the log file of the Weaver engine. By default, the log files are located in this
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folder: C:\Users\[username]\Connect\logs\WeaverEngine, where [username] is your

own Windows user name.

Search the log file for "PPM" (pages per minute). Repeat this a few times to determine the

average output speed.

Likewise, the output speed for an Email or Web template can be found by running it with

one Merge engine and the maximum target speed per job. In the Merge engine's log file,

search for "PPM".

If your jobs are not running at the licensed speed, there may be several ways to improve per-

formance, as described below. Make sure to address all issues mentioned in this topic

before deciding that you need to invest. Note however that it is not guaranteed that the

licensed speed can be achieved with any job. Creating output for templates with very com-

plex scripts or complex graphics resources will take a certain amount of time, even on high-

end hardware.

Improving performance beyond what can possibly be reached by using the methods

described below requires purchasing a Performance Pack (see Performance Packs).

For advice please contact your local sales office (see Upland Objectif Lune's Contact page).

Engine configuration
As explained in another topic (Connect: a peek under the hood) the Connect Server cooper-

ates with different engines to handle specific tasks.

A DataMapper engine extracts data from a data file. A Merge engine merges the template

and the data to create Email and Web output, or to create an intermediary file for Printed

output. The intermediary file is in turn used by a Weaver engine to prepare the Print output.

A Merge engine merges the template and the data to create an intermediary file for Printed

output. The intermediary file is in turn used by a Weaver engine to prepare the Print output.

Configuring these engines to match both the hardware configuration and the typical usage

situation is probably the most effective way to improve Connect's performance.

The number of engines is one of the "Parallel Processing Preferences" that let the Connect

Server manage its workload in such a way that the highest possible output speed is

achieved.

For an explanation and guidelines to these settings, see "Engine configuration" on page 84

and "Parallel Processing preferences" on page 93.

Note: Connect Server and Connect Designer each have their own distinct scheduling

preferences.
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Use the Connect Server Configuration tool to change the Connect Server settings and

Designer > Windows >Preferences for changing Designer settings.

Template optimization
When you find that the speed per Merge engine - the Content Creation speed - is low, optim-

izing a template can make a huge difference. For advice on how to optimize a template see:

Optimizing a template.

Network and internet connections
Use a fast network and internet connection or avoid loading external or internet resources.

Using images, JavaScript or CSS resources located on a slow network or on a slow internet

connection will obviously lead to a loss of speed. While we do our best for caching, a doc-

ument with 5,000 records which queries a page that takes 1 second to return a different

image each time will, naturally, slow output generation down by up to 83 minutes.

Hardware configuration
When processing speed is important, the following is suggested after addressing the other

issues mentioned in this topic.

l Antivirus exclusions. Sometimes, virus scanners, other security software or indexing

services can interfere. It can help to disable those kinds of tools for the areas where

Connect stores intermediate files. You could exclude the entire C:\User-

s\<connectuser>\Connect folder. See also: "Antivirus Exclusions" on page 7.

l Use a high-performance, low-latency hard drive. Connect benefits from fast I/O. This

is especially true for DataMapper engines (see "DataMapper engine" on page 88).

Preferably use a Solid State Drive (SSD) or similar for storage.

l Use at least 8+ GB High-Quality RAM. Check memory usage while the Print command

is being executed to see if you need more than the minimum of 8GB. Assuming that

the Connect Server and the Connect database need 1GB each, and that each engine

needs 1GB as well, you can roughly estimate how much memory is needed.

l Consider using a physical machine instead of a virtual machine. When running on a

Virtual Machine, the machine may report that it has sufficient hardware (cores) avail-

able, but in a virtual environment you need to make sure that this hardware is not

being shared with lots of other virtual machines.

l Consider using hardware with more physical cores. OL Connect doesn't limit the num-

ber of Merge engines that is used for a Print job, so if the number of physical cores is

low, it makes sense to see if that can be increased. When running on a virtual
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machine, this is usually easy. When running on a physical machine, it means that you

may have to switch hardware.

l For both virtual and non-virtual environments, make sure the machine is not busy with

all kinds of other processes.

System requirements
These are the system requirements for OL Connect 2023.2

Operating system
Any 64 bit Windows Desktop or Server version that is actively supported by Microsoft.

New versions of Windows are supported within the first 6 months of their commercial

release.

Supported virtual environments
l VMWare vCenter/vSphere

l Microsoft Hyper-V/Azure

l Amazon Web Services (AWS)

Note: Multi-user environments like Terminal Services or VMWare Horizon are not offi-

cially supported.

Recommended system requirements for the OL Connect / Workflow servers
As with any software application, minimum hardware requirements represent the most

basic hardware on which the software will run. Note however that settling for the minimum

specification is unlikely to produce the performance you expect from the system. It can be

used when configuring a trial or a development system, however.

l CPU: at least 8 64-bit logical processors (aka threads)

l RAM: at least 16 GB

l Storage: at least 100GB available on fast SSD for the system drive (by default this

means the C: drive)

l Networking: at least 1Gbps

Note: These values are for the OL Connect Servers when used in production. The OL

Connect Designer and the Workflow Configuration Tool can be used on systems with

lower hardware specifications, so long as they are not used to generate production

output.
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A word of caution
OL Connect is used for a very wide variety of applications. Consequently, it is difficult to

determine which system configuration will produce the best results for any given applic-

ation. The specifications above are therefore meant as general guidelines that should pro-

duce the expected results for most implementations.

Keep in mind, however, that they may not represent the optimal configuration for your par-

ticular application.

Rules of thumb
When installing on multiple PCs, keep the following rules of thumb in mind:

l The more logical processors, the better

l Higher CPU clock speeds are recommended: 24 logical processors @3GHz may per-

form better than 32 logical processors @2.2 GHz, depending on the workload

l For each additional logical processor, plan to add 2 GBs of RAM

l The number of logical processors is in direct relation with the number of OL Connect

engines that can efficiently run concurrently
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Installation and Activation
This topic provides detailed information about the installation and activation of OL Con-

nect 2023.2.

Note: A PDF version of this guide is available for use in offline installations. Click here

to download it.

OL Connect 2023.2 is comprised of 2 different installers: one for the OL Connect software

and one for OL Connect Workflow 2023.2.

Where to obtain the installers
The installers for OL Connect 2023.2 and Workflow 2023.2 can be obtained on DVD or down-

loaded as follows:

l If you are a Customer, the installers can be downloaded from the Upland Objectif

Lune Web Activation Manager (https://www.objectiflune.com/webactivationmanager/)

or through the OL Update Manager if it is activated.

l If you are a Reseller, the installers can be downloaded from the Upland Objectif Lune

Partner Portal site (https://extranet.objectiflune.com/) or through the Upland OL

Update Manager if it is activated.

Installation - important information
For important information about the Installation, including requirements and best prac-

tices, please see the following topics:

l "Installation prerequisites" on the next page

l "User accounts and security" on the next page

l "Migrating to a new workstation" on page 46

l "Upgrading from previous Connect versions" on page 54

Installation - "How to" guides
For information on how to conduct the installation itself, choose from the following topics:

l "Installation Wizard" on page 24

l "Running Connect installer in Silent Mode" on page 34

l "Installing OL Connect on machines without internet access" on page 23

Activation
For information on licensing, please see "Activating a License" on page 43.

Page 20

https://help.uplandsoftware.com/objectiflune/en/archive/olconnect-installation-guide-2023-2.pdf
https://help.uplandsoftware.com/objectiflune/en/archive/olconnect-installation-guide-2023-2.pdf
https://www.objectiflune.com/webactivationmanager/
https://extranet.objectiflune.com/


Installation prerequisites
l Make sure your system meets the "System requirements" on page 18.

l OL Connect Version 2023.2 can be installed under a regular user account with Admin-

istrator privileges., see "User accounts and security" below.

l OL Connect must be installed on an NTFS file system.

l OL Connect requires Microsoft .NET Framework 4.5 already be installed on the target

system.

l Connect 2019.1 requires updated Connect License and/or Update Manager.

See "Upgrading from previous Connect versions" on page 54 for details.

l In order to use the automation features in Version 2023.2, OL Connect Workflow

2023.2 will need to be installed.

This can be installed on the same machine as an existing PlanetPress® Suite 7.x install-

ation or on a new computer.

For more information, please see "Information about OL ConnectWorkflow" on page 77.

If Workflow installation finds that .NET 4.0 is not already installed, it will install that

version as part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then

.NET 3.5 must also be installed. This will need to be installed manually, as .NET 3.5 is

not included in the Workflow setup.

User accounts and security
Windows user account
Connect requires local Windows Administrator rights when installing the software and activ-

ating the software license. This is to allow read/write access to protected Windows folders

and registry entries.

Once installed Connect requires only standard Windows user credentials to run.

The following links contain the details as to when and where Windows Administrator rights

are required:

l Connect Installation: "Installation Wizard" on page 24

l Activating Connect: "Activating OL Connect" on page 45
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Permissions for OL Connect Designer

OL Connect Designer does not require any special permissions to run besides that of a reg-

ular program.

It does not require administrative rights and only needs permission to read/write in any

folder where templates or data mapping configurations are located .

If generating Print output, OL Connect Designer requires permission on the printer or

printer queue to send files.

Permissions for OL Connect Server

The OL Connect Server module, used by the Automation module, requires some special per-

missions to run. These permissions are set during installation, in the Engine Configuration

portion of the "Installation Wizard" on page 24, but it can also be configured later by modi-

fying permissions for the service. To do this:

l In Windows, open the Control Panel, Administrative Tools, then Services (this may

depend on your operating system).

l Locate the service called Serverengine_UUID , where UUID is a series of characters

that depend on the machine where the software is installed.

l Right-click on the service and select Properties.

l In the Connection tab, define the account name and password that the service should

use. This can be a local account on the computer or an account on a Windows

Domain. The account must have administrative access on the machine. It should also

correspond to the user account set up in Worfklow.

OL Connect Server user accounts
By default, authentication is enabled on the Connect Server. During a new installation the

OL Connect Server's default authentication must be configured by specifying a user name

and password. The default username for new installations is olc-user.

More user accounts can be configured in the Server Configuration Tool (see "Security and

Users Settings" on page 83).

In any Connect Designer that uses a secured Connect Server, an authenticated user

account must be specified via the Designer's Preferences (see the Connect Servers pref-

erences sub-section of the Designer Preferences dialog).

Note that prior to OL Connect version 2020.2, only one user account could be configured on

a Connect Server. The default username was ol-admin and the default password was

secret.
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Installing OL Connect on machines without internet access
Installing OL Connect2023.2 in offline mode requires some extra steps. These are listed

below.

Updating Connect
Updating to OL Connect 2023.2 from earlier Connect version

In order to update OL Connect to 2023.2 it is first necessary to update the OL Connect

license and Update Manager .

For further details on how to upgrade the OL Update Manager to the latest version and

update your OL Connect License see the Update Manager 1.7 - Upgrade Guide.

For full details on how update OL Connect see "Upgrading from previous Connect versions"

on page 54.

Initial Connect Installation
GoDaddy Root Certificate Authority needs to be installed
In order to install OL Connect it is necessary for the GoDaddy Root Certificate Authority to

be installed (G2 Certificate) on the host machine and for this to be verified online. When a

machine hosting the installation does not have access to the Internet, the installation will

fail because the verification cannot be performed. To solve this problem one must first

ensure that all Windows updates have been installed on the host machine. Once the Win-

dows updates are confirmed as being up to date, then complete the following steps:

1. Go to https://certs.godaddy.com/repository and download the following two cer-

tificates to copy to the offline machine:

l GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdroot-

g2.crt

l GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is

gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps

through the subsequent wizard.

3. Now copy the OL Connect installer to the offline machine and start the installation as

normal

Windows certificate validation - Certificate Revocation List retrieval should be
switched off

For your security Upland Objectif Lune digitally signs all relevant files with our own name

and certificate. The integrity of these files is checked at various times by different, context

related, methods. One of these checks, done during the installation process, uses the
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Windows certificate validation check. .

The Windows certificate validation process not only checks the integrity of a file against its

signature, but also usually checks if the certificate itself is still valid. That check is done

against the current Certificate Revocation List (CRL), which needs to be retrieved from the

internet. However, if the machine in question does not have internet access, the retrieval of

the CRL must fail, which will lead to subsequent validation issues.

To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to

installing Connect on machines without internet access. There is no security risk associated

with this, as the CRLs would never be retrievable without internet access, anyway. Advant-

age of the switch will not only be found during the installation and operation of Connect,

but also in some speed improvements for any application which use signed binaries.

To switch off CRL retrieval on the computer, complete the following steps:

1. Open the “Internet Options” via the Control Panel

2. Select the “Advanced” tab and scroll down to “Security” node.

3. Uncheck the entry “Check for publisher’s certificate revocation” under that node.

4. Click the OK button to close the dialog.

5. Re-start the computer.

Installation Wizard
Updating from Connect versions predating 2019.1
In order to update OL Connect to 2023.2 from Connect versions prior to 2019.1 it is first

necessary to update the Connect License.

For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on

page 54

Starting the OL Connect installer
The OL Connect installer is supplied as an executable file.

Double click on the executable file and after a short pause the Setup Wizard will appear to

guide through the installation steps.

Note: OL Connect requires prior installation of Microsoft .NET Framework 4.5.

For a full list of other prerequisites, see "Installation prerequisites" on page 21.
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Note: It is recommended to install and use OL Connect Designer and Server under the

same user account. If you install and run OL Connect Designer and Server under dif-

ferent user accounts (for example, install as User1 and run Designer as User2), account

permission issues may occur.

Running the Installation with extra logging

The installer can be run with enhanced logging options, if needed.

To do so, run the OL_Connect_<<Edition>>_2023.2.n.nnnnn_bnnnn.exe (replace <<Edition>>

with either Enterprise, Professional or Desktop) from the command line with one of the fol-

lowing command line options:

l OL_Connect_<<Edition>>_2023.2.n.nnnnn_bnnnn.exe --verbose

This adds extra debugging style logging to the installation process.

l OLConnect_<<Edition>>_2023.2.n.nnnnn_bnnnn.exe --trace

This adds full trace style logging to the installation process. The log file this produces

will be very large, as this option logs everything.

Prerequisites Installation
The installer will check for prerequisite technologies as the first step in the installation pro-

cess. If this check finds some technologies are missing, it will install those technologies,

before continuing with the installation.

Welcome screen
After any prerequisites are installed, the installer Welcome screen appears.

Click Next to continue with the installation.

If the installation is an upgrade over a pre-existing OL Connect installation, the installer will

first uninstall the earlier version.

If you would like to retain the usage information from that pre-existing OL Connect install-

ation, do not select the Remove User data checkbox option.

For information about exactly what data would be saved or deleted, please see "Pre-exist-

ing User Data" on page 57.

License Agreement
The next page displays the End User License Agreement, which needs to be read and accep-

ted before clicking Next.
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Component Selection
After clicking the Next button, the Component Selection page appears, in which the dif-

ferent components of OL Connect can be selected for installation.

The options are:

l Base: The installation files required for any OL Connect installation. This component is

not optional.

l Designer: The Designer module (see The Designer) can be installed standalone (with

no other installed modules) on as many machines as you like. It does not require a

license to run as a standalone designer tool . This allows any number of people to use

the Designer for creating jobs, but without production capabilities such as automation

and commingling. The Designer module is optional, but it is recommended that it

always be installed.

l Messenger: The Messenger Service that allows connection between OL Connect's

Designer and Workflow. Recommended for all production installations.

l Server: The Connect Server back-end that provides Connect production capabilities

such as production content creation (print output, HTML content for emails and web

pages), automation, commingling and picking. It is also referred to as the Connect

Master Server in Connect clustered environments.

Note: (Enterprise edition only) When either the Designer or the Server com-

ponent is selected for installation, the AFPmerge tool is installed as well. This

command line tool can embed resources in AFP data files and merge multiple

AFP data files into one AFP file. For information about its use, see: .

l OL Connect Server Extension (Enterprise edition only): A Client server that is sub-

servient to the main OL Connect Master Server module. When a Client server is

installed it communicates with the Master server in order to shares tasks with it. Such

an installation assumes that the Connect Server (the Connect Master Server) has pre-

viously been setup on another machine, and that the database option "Allow remote

client access” option were selected during that installation.

Before installing the software, make sure that both TCP/IP ports 3306 and 9340 are

open on the Connect Master Server and Connect Extension Server, in both the

Inbound and Outbound Firewall Rules. Access within the Private and Domain profiles is

sufficient.

It is recommended your firewall blocks access to port 3306 from external requests as
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it may represent a security risk if the machine is open to the internet!

For further information refer to the Binding and Root access on the Master server

instructions in "Server Clustering" on page 100.

Note: Only one of the Server or Server Extension can be installed on a single

machine, not both.

l Print Manager (Enterprise edition only): The Print Manager module (see Print

Manager) is required for handling IPDS print output, but may also be optionally

installed for managing PCL and PostScript print output.

The Print Manager can be installed standalone and can be installed on more than one

machine.

l MariaDB Server: A supplied MariaDB database used by OL Connect.

The database is used for referencing temporary Connect files and for sorting tem-

porarily extracted data, and similar.

Note: When performing an upgrade installation, if the MariaDB version has not

significantly changed, then no attempt will be made to upgrade the database

content.

If there is a significant MariaDB version change, the database content will be

upgraded, so that it will continue to work with the new MariaDB version.

A pre-existing MariaDB, MySQL or Microsoft SQL server (referred to as an external

database, in this documentation) could be used instead, for the same purposes. The

external database could reside on the same computer or on a separate server.

If you wish to make use of an external database, please make sure the MariaDB option

is not selected.

Caution: If you chose not to install the supplied MariaDB database, and instead

opt for using a pre-existing (External) database then you yourself must ensure

that the External database is accessible to Connect.

Upland Software, Inc. will take no responsibility for setting up database con-

nections to any but the supplied MariaDB database.

See "Database Considerations" on page 9 for more information about setting up

external databases.
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Note: (Enterprise edition only): All instances of OL Connect Server (Master) and

OL Connect Server Extension (Clients) must use the same instance of MariaDB.

Whilst it is possible for each separate client installation to have its own MariaDB

instance, doing so will prevent the Servers from functioning together within a

"Server Clustering" on page 100 environment.

The single MariaDB instance can be on any machine, however, whether it be the

Server (master) or one of the Server Extension (client) machines.

l Destination folder: This is the location where Connect components are to be installed.

Use the Browse button to navigate to a folder other than the default, if required.

Note: The installation path cannot contain any non ASCII characters (such as

Asian language Unicode characters). Nor can it contain characters that Win-

dows disallows in filenames (such as '?', '>' or trailing spaces).

If an invalid character is entered, the Installation Path entry box will turn red and

a description of the error will be displayed in the information area.

The installer calculates how much disk space is required for installing the selected com-

ponents, along with how much space is available.

l Total Required Space : Displays the amount of disk space required for the selected

components.

l Space Remaining: Displays the amount of space available after installation on the

drive currently in the Installation Path.

OL Connect Service Configuration
The Service Configuration page is for setting the Microsoft Windows Account that the Con-

nect Service component will use.

l Log on as: Defines the Windows user account and password that the Connect Server

services will use.

Note: The Windows user account must have access rights to all local and net-

work resources required for production, as well as Windows "Log on as a Service"

rights.

The Windows user account selection entered here should be recorded for future
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use, as the "Security and Users Settings" on page 83 dialog can only ever be

executed through the user account specified on this page.

l Account: The Windows user account that the service uses to login. If the machine

is within a domain, use the format domain\username.

This account must be an existing Windows profile with local Administrator rights.

l Password: The password associated with the selected user.

Use the eye icon to toggle between displaying or masking the password

entry.

The password is not validated for password strength, so any entry is acceptable.

l Validate Account button: Click to verify that the entered account and password

combination is correct and that the service is able to login.

Note: This button must be clicked and the user validated before the Next

button becomes available.

l Start service when installation is complete checkbox: Select this option to have the

service start upon installation completion (which is the default).

If unchecked, the Service will start upon machine reboot.

OL Connect Server Connection
Set the Connect Server Connection internal username and password.

The Server Connection settings will be slightly different depending upon whether Connect

Server or Connect Server Extension was selected for installation (Enterprise edition only).

The options available are as follows:

l Host: This option is only available if Connect Server Extension was selected for install-

ation.

Enter the machine name or IP Address where the Connect Master Server resides.There

is no requirement for the Master and Extension servers to belong to the same IP sub-

net.

IP subnetting is beyond the scope of this documentation, but more information can be

found here: https://en.wikipedia.org/wiki/Subnetwork.

l Port: Enter the port to use to communicate with the Connect Server.

By default the Connect Server controlled by the OLConnect_Server service com-

municates through port 9340.
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l User: Enter the internal username for connection to the OL Connect Server.

The default username for new installations is olc-user.

l Password: The password associated with the selected user.

Use the eye icon to toggle between displaying or masking the password entry.

The password is not validated for password strength, so any entry is acceptable.

Note that prior to OL Connect version 2020.2, only one user account could be configured on

a Connect Server. The default username was ol-admin and the default password was

secret.

Database Configuration
The Default Database Configuration page appears if the supplied MariaDB module was

selected for installation in the Product Selection screen. It defines the administrative root

password for the MariaDB server as well as which port it uses for communication.

The installer will automatically configure the Connect Server to use the supplied password

and port.

l Port: The port on which MariaDB will expect requests to come though, and through

which it itself responds.

A check is run to confirm whether the specified TCP\IP Port Number is available on the

local machine. If it is already being used by another service (generally, an existing

MySQL or MariaDB installation), the number is highlighted in red and a warning mes-

sage is displayed.

Note: The MariaDB database controlled by the OLConnect_MariaDB service com-

municates through port 3306 by default.

l Root password: Enter the password for the 'root', or administration account, for the

MariaDB server.

Use the eye icon to toggle between displaying or masking the password entry.

We recommend that the password be at least 8 characters long and contain at least

one of each of the following, even though password selection strength is not enforced

by the installer:

l a lower case character (a, b, c ... )

l an upper case character (A, B, C ...)
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l a numeric digit (1, 2, 3 ...)

l a punctuation character (@, $, ~ ...)

For example: "This1s@K"

Note: When updating from an earlier Connect version, the appropriate

MariaDB password must be entered or the update will fail.

If the password is subsequently forgotten, then MariaDB must be uninstalled and

its database deleted from disk before attempting to reinstall.

l Allow remote client access checkbox: Click to enable external access to the

MariaDB server.

Note:
This option is required if setting up clustering, or if the MariaDB Server will need

to be accessed from any other machine.

It will also be required if the MariaDB database is on a separate machine to this

OL Connect installation.

Tip: This option may represent a security risk if the machine is open to the inter-

net.

We heavily recommended that your firewall is set to block access to port 3306

from external requests.

l Username: Enter the MariaDB user name that will be associated with OL Connect.

The default username for new installations is olconnect.

l Password: The password associated with the selected user.

Use the eye icon to toggle between displaying or masking the password entry.

The password is not validated for password strength, so any entry is acceptable.

Configuring External Database Connection
The Database Connection page appears if the supplied MariaDB module was not selected

for installation. This page is for setting up the connection to an existing External database.

l System: Select the database type to use for theOL Connect Engine. Currently only

MariaDB, MySQL and Microsoft SQL Server are supported.
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l Host: Enter the IP Address or alias of the server where database resides.

l Database Instance Name: Enter an existing Microsoft SQL Server's instance name.

This option only applies to existing Microsoft SQL Server instances, and not for Mari-

aDB or MySQL.

Note that the MS SQL Server instance name must meet Microsoft's requirements.

l Port: Enter the port on which the database server expects connections.

For MariaDB and MySQL, this is 3306 by default.

For Microsoft SQL Server it is 1433 by default.

l Schema: Enter the name of the database into which the tables will be created.

The standard Connect schema name is "olconnect" by default.

l Username: Enter the user account of a user with database administrative rights.

Administrative rights are required since tables will need to be cre-

ated/modified/dropped in the database.

If accessing a database on a different machine, the server must also be able to accept

non-local TCP connections and the user account must also be configured to accept

remote connection.

For example, the "root" MySQL user entered as root@localhost is not allowed to con-

nect from any other machine than the one where MySQL is installed.

l Password: Enter the password for the above user account. For MySQL the appropriate

password must be entered or the Connect installation will fail.

l Encrypt Connection checkbox: Check to enable encrypted connections to the

external database.

The secure connection to MySQL is for the "olconnect" schema.

Note: It is not in the scope of the Connect installer to configure the MySQL data-

base Server to accept SSL connections. This must be done prior to the install-

ation of Connect.

By default, the connection will not verify the server certificate (veri-

fyServerCertificate=false), which would allow connecting to a server using a self-

signed certificate. If such a certificate is required, then this setting can be

changed after installation within the Database Connection preferences (which

can be accessed from either the "Server configuration settings" on page 79 tool,

or the Designer Preferences window).
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l Test Connection button: Click to verify that the information provide into previous

fields is valid by connecting to the database.

Note: This test does not check whether the remote user has READ and WRITE per-

missions to the tables under the objectiflune schema. It is solely a test of data-

base connectivity.

Ready to install
This page confirms and lists the installation selections made.

If components have been selected which have a shortcut associated with them (Designer,

Print Manager, Server) then you will presented with the option to Create desktop shortcuts.

Select if you wish for desktop icons to be created.

Click Install to start the installation itself. This process can take several minutes.

Installation Finished
This screen describes a summary of the components that have been installed.

l Configure update checks checkbox: This option is enabled by default. It causes the

Product Update Manager to run after the installation is complete. This allows con-

figuring OL Connect to regularly check for entitled updates.

Note: this checkbox may not be available in the event that an issue was encountered

during the installation.

When ready, click the Finish button to close the installation wizard, and initialize the

Product Update Manager, if it was selected.

The Product Update Manager
If the Configure Update Check option has been selected, a message will be displayed after

clicking “Finish” in the setup. The message details the information that needs to be sent

back to Upland Software, Inc. in order to determine when/if the software needs updating.

Click “Yes” to install or open the Product Update Manager where the frequency with which

the updates can be checked and a proxy server (if required) can be specified.

Note: If the Product Update Manager was already installed by another Upland Soft-

ware, Inc. application, it will be updated to the latest version and will retain the set-

tings previously specified.
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Select the desired options and then click OK to query the server and obtain a list of any

updates that are available for your software.

l Note that the Product Update Manager can also be called from the “Objectif Lune

Update Manager” option in the Start menu.

l It can be uninstalled via Control Panel | Programs | Programs and Features.

Product Activation
After installation, it is necessary to activate the software. See "Activating a License" on

page 43 for more information.

Before activating the software, please wait 5 minutes for the database to initialize. If the

software is activated and the services rebooted too quickly, the database can become cor-

rupted and require a re-installation.

Running Connect installer in Silent Mode
Updating from Connect versions predating 2019.1
In order to update OL Connect to 2023.2 from Connect versions prior to 2019.1 it is first

necessary to update the Connect License.

For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on

page 54

General information
OL Connect can be installed from the command line in "silent mode" to allow for scenarios

such automated installations during company wide roll-outs, or to allow for unattended

out-of-hours updates. The trigger for the Connect Installer to run in silent mode is a text file

with the fixed name installProperties.ini located in the same folder as the OL Connect

installation executable file.

How to prepare the installProperties.ini file is detailed in the following sections.

Installation Properties file
The basic rules for the installProperties.ini file are:

l Comment Lines start with the semi-colon character ';'

Example: ; The options to configure an external database

l The properties are listed in Key = Value pair format.

Example: product.ServerExtension = false

l Quotes are used for path strings, but not for other string types
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Example: path = "c:\Program Files\Objectif Lune\OL Connect"

l Property values are case insensitive

The installation settings fall into three distinct categories:

l "[Logging]" below for setting the installation logging options.

l "[Installation]" on the facing page for selecting what gets installed.

l "[Uninstall]" on page 39 handles properties related to product Uninstallation. These

also impact Maintenance mode.

[Logging]

This section handles Silent Installer logging options.

The logging Key pairs are as follows:

l verbose: Boolean (Default: false)

A basic log is always created by the installer, with or without the verbose option. The

verbose option is more suitable for debugging purpose.

If set to true, then a verbose log file is created in the logging path specified in the

INI file.

If no logging path is specified in the INI file, then the default one is used.

If set to false, standard logging is done.

l path: String (Default: %PROGRAMDATA%\Objectif Lune\Installation Logs)

Sets the folder to which the installation log will be written.

Only the log folder should be specified here, not the log file name.

Note: The log file name's format is set automatically and uses the format

Installer-YYYY-MM-DD-####.#.#.log, where:

l YYYY-MM-DD = The date the log was created

l ####.#.# = The OL Connect version number

The file name for a maintenance installation begins with "Maintenance" rather

than "Installer"

Example:

; Logging properties
[Logging]
verbose = false
path = "c:\temp\Silent Install"
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[Installation]

This section handles various installation parameters as well as product selection.

The logging Key pairs are as follows:

l product.<name>: Boolean (Default: false)

Each OL Connect product has its own entry, which can be set to true (to install) or

false (to omit from installation).

What products are available for installation is determined by which OL Connect brand-

ing is being installed. The products for OL Connect branding are as follows:

l product.Designer

l product.PrintManager (Enterprise edition only)

l product.Server

l product.ServerExtension (Enterprise edition only)

l product.MariaDB

l product.Messenger

l path: String (Default: %PROGRAMFILES%\Objectif Lune\OL Connect)

Sets the installation root folder for the OL Connect applications.

l RegisterService.connectServer: Boolean (Default: true)

Register the Server (or Server Extension in the Enterprise edition) services or not

(such as in the case of a container).

l server.username: String (Default: the current user/domain installing the service)

Determines the domain and username to be used when configuring the Server (or

Server Extension in the Enterprise edition) service.

The username can use the following syntax formats:

l username

l domain\username

(Note: the backslash between the domain and user names needs to be escaped

by another backslash. For example: server.username = ourcom-

pany\\pbrown01)

l username@domain

l server.password: String (Default: there is no default for this setting)

Password to use when registering the Server (or Server Extension in the Enterprise edi-

tion) service.
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l database.configure: Boolean (Default: true)

If set to "false", then the database configuration is skipped.

Note: If database configuration is skipped (database.configure = false),

then none of the database.xxx properties below are required, and these prop-

erties will be ignored, even in they are included in the INI file.

l database.system: String, Optional (Default: there is no default for this setting)

Entry needs to be from one of the following options: mariadb, mysql, mssqlserver

Note: If product.MariaDB = true has been set:

l This setting becomes optional. Otherwise it is required.

l The value is required to be mariadb, if the value is to be provided.

l database.host: String, Optional (Default: there is no default for this setting)

If product.MariaDB = True has been set, this value is required to be set to loc-

alhost, if provided.

l database.port: Numeric, Optional (Default: MariaDB's default port, 3306)

The database engine port.

The required entry depends upon the selection made in database.system.

If product.MariaDB = True, then the port should be set to 3306.

l database.rootpassword: String (Default: there is no default for this setting)

Database root password.

There is no default value, and if this is left unspecified the installation will fail.

l database.remoteaccess (Enterprise edition only): Boolean (Default: depends upon

whether the Connect Server is installed.

If the property product.Server = true, then the default is false.

If product.Server = false or is left unspecified, then the default is true)

When set to true the database will be configured to accept connections from systems

other than localhost.

l database.username: String (Default: olconnect)

The username that OL Connect will use to connect to the database.

l database.password: String (Default: there is no default for this setting)

The password that OL Connect will use to connect to the database.

There is no default value, so if this is left unspecified, then the installation will fail.

l database.instance: String, Optional (Default: there is no default for this setting)

Only valid if database.system = mssqlserver.
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l database.schema: String (Default: there is no default for this setting)

Specifies the database schema to use. Required. (Optional if product.MariaDB =

true)

l database.encryptedconnection: Boolean (Default: False)

Specifies the database schema to use.

(Optional if if product.MariaDB = true)

l server.connection.configure: Boolean, Optional (Default: True)

If set to False, then the server connection configuration is skipped.

l server.connection.user: String (Default: olc-user)

The server connection username.

l server.connection.password: String (Default: there is no default for this setting)

The server password. Required if server.connection.configure = true.

l server.connection.port: Numeric (Default: 9340)

The server port number.

l server.connection.host (Enterprise edition only): String (Default: there is no default for

this setting)

The server host. Required only for the Server Extension if serv-

er.connection.configure = true.

l desktopShortcuts: Boolean (Default: False)

Specifies whether desktop shortcuts are to be added or not.

This flag only takes effect if components were selected which have a shortcut asso-

ciated with then (Designer, Print Manager (Enterprise edition only), Server). If no such

were selected, then this flag will have no effect.

l Language: String, Optional

Sets the OL Connect application language settings.

Supported user locales (as language code) are as follows:

l English: en

l French: fr

l German: de

l Italian: it

l Japanese: ja

l Spanish: es

l Portuguese (Brazil): pt
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l Chinese (PRC/TW): zh

l Korean: ko

l Locale: String, Optional

Sets the OL Connect application's region using a country code. For example: US, UK,

DE, CH.

If this property is not set, the locale defaults to the system locale, and if that is not

found, the selected installation language will determine a default locale.

Example:

; Installation settings
[Installation]
product.Designer = true
product.Server = true
product.PrintManager = true
product.ServerExtension = false
product.MariaDB = true
product.Messenger = true
RegisterService.connectServer = true
server.username = Administrator
server.password = ObjLune
server.connection.user = olc-user
server.connection.password = secret
database.rootpassword = @Admin2022
database.username = olconnect
database.password = @Admin2022
database.remoteaccess = true
desktopShortcuts = true
path = "c:\Program Files\Objectif Lune\OL Connect"
Language = fr
Locale = FR

[Uninstall]

This section handles properties related to Uninstallation, but also Maintenance mode install-

ations.

These options have no effect at all if OL Connect is not present on the system.

The logging Key pairs are as follows:

l remove: Boolean (Default: False)

If the present version of the installer is already installed, this property defines the

installer behaviour.

The installer will perform a Remove MSI action on OL Connect if remove = true,

whilst a Modify MSI action will be performed if remove = false.

Note: This option has no effect if the product is not installed on the current sys-

tem
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Note: If the Remove action is taken, then the equivalent of an uninstall is done,

while a Modify action will change the components installed on the system based

on the ones defined in the INI file [Installation] section, allowing removal or addi-

tion of components in the current installation.

l keepdata: Boolean (Default: True)

Allows the user to specify if they wish to keep or remove user data (located under

%PROGRAMDATA%\Objectif Lune\OL Connect when performing a product uninstall.

Example:

; Uninstallation/Repair properties
[Uninstall]
remove = true
keepdata = true

Properties file examples
Simple Connect installation example

Here is an example of a complete installProperties.ini file for a relatively simple OL Connect

installation.

; OL Connect silent installer properties

; Logging properties
[Logging]
verbose = false
path = "c:\ProgramData\Objectif Lune\Installation Logs"
; 

Installation settings
[Installation]
product.Designer = true
product.Server = true
product.PrintManager = true
product.ServerExtension = false
product.MariaDB = true
product.Messenger = true
RegisterService.connectServer = true
server.username = Administrator
server.password = ObjLune
server.connection.user = olc-user
server.connection.password = secret
database.rootpassword = @Admin2022
database.username = olconnect
database.password = @Admin2022
database.remoteaccess = true
desktopShortcuts = true
path = "c:\Program Files\Objectif Lune\OL Connect"

;Optional uninstallation settings
[Uninstall]
remove = true
keepdata = false

Server Extension installation example

The following is an example of a complete installProperties.ini file for a Server Extension

installation (Enterprise edition only).
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; OL Connect silent installer properties for Server Extension installation

; Logging properties
[Logging]verbose = false
path = "c:\ProgramData\Objectif Lune\Installation Logs"

; Installation settings
[Installation]
product.Designer = false
product.Server = false
product.PrintManager = false
product.ServerExtension = true
product.MariaDB = false
product.Messenger = true
RegisterService.connectServer = true
server.username = Server EX2
server.password = objlune
database.system = MariaDB
database.host = 192.168.108.50
database.username = root
database.password = Admin@123
database.schema = olconnect
database.encryptedconnection = false
database.rootpassword = Admin@123
database.remoteaccess = true
desktopShortcuts = true
server.connection.configure = true
server.connection.host = 192.168.108.50
server.connection.port = 9340
server.connection.user = ol-admin
server.connection.password = secret
path = "c:\Program Files\Objectif Lune\OL Connect"

; Optional uninstallation settings
[Uninstall]
remove = true
keepdata = false

Exit Codes
Success

l 0 = Installation completed successfully / no specific error code was returned.

Pre-Installation Check (200s)

l 201: Operating system is not 64-bit

l 202: Windows Operating System is too old (pre-Windows 7)

l 203: Minimal UAC prerequisites were not met

l 204: Installation user did not have administrator rights

Silent installation properties (300s)

l 301: MariaDB product was selected, but no root password was supplied

l 302: MariaDB product was selected, but no user password was supplied

l 303: User provided database is to be used, but database.system property was miss-

ing

l 304: User provided database is to be used, but database.system property had invalid

value
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l 305: User provided database is to be used, but database.host property was missing.

l 306: database.instance property was used with a database system other than MS SQL

Server

l 307: User provided database is to be used, but database.username property was miss-

ing.

l 308: User provided database is to be used, but database.password property was miss-

ing.

l 309: Connect server / server extension product was selected, but serv-

er.connection.password property was missing

l 310: Connect server extension product was selected, but server.connection.host

property was missing

Upgrade errors (400s)

l 401: Some Connect applications were running and need to be closed before install-

ation can proceed.

l 402: The installer brand does not match the brand of the OL Connect version currently

installed. (PlanetPress)

l 403: The installer brand does not match the brand of the OL Connect version cur-

rently installed. (PReS)

l 404: The installer brand does not match the brand of the OL Connect version cur-

rently installed. (Printshop Mail)

License file validation (500s)

l 501: OL Connect license file is in older format

l 502: License Care Date does not allow installation of product

l 503: License brand mismatch with installer brand

Destination and selected product check (600s)

l 601: Server and Server Extension both were selected to be installed.

Only one of the two may be installed on any one system.

l 602: No component was selected to be installed

l 603: Destination folder is invalid or there is too little disk space available

Installation aborted (700s)

l 701 - 725: Installation was aborted due to user cancellation
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Service stop error (800s)

l 801: OLConnect_MySQL/OLConnect_MariaDB service could not be stopped during

uninstallation

Activating a License
OL Connect and OL Connect Workflow both come with individual 30 day trial license peri-

ods during which time it is not necessary to have a commercial license to run the applic-

ations.

This allows time for reviewing the applications and for organizing a commercial license. If a

modification to the trial license is required, such as to allow an extension to the trial period,

or for extra functionality, then a new activation code will need to be requested.

Obtaining the OL Connect Magic Number
To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Num-

ber is a machine-specific code that is generated based on the computer's hardware and

software using a top-secret Upland Objectif Lune family recipe. Each physical computer or

virtual computer has a different Magic Number, and each requires a separate license file to

be functional.

To get the OL Connect Magic Number open the OL Connect Software Activation applic-

ation.

l Open the Start Menu

l Click on All Programs and browse to the Objectif Lune folder.

l Open the OL Connect Software Activation shortcut.

l The OL Connect Software Activation application consists of the following:

l License Information subsection:

l Magic Number: Displays the OL Connect Magic Number.

l Copy the magic number to the clipboard: Click to copy the Magic Num-

ber to the clipboard. It can then be pasted in the activation request email

using the Windows CTRL+V keyboard shortcut.

l Licensed Products subsection:

l Name: Displays the name of the application or module relevant to this activ-

ation.

The Information button provides detailed information about the applic-

ation or module license.
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l Serial Number: Displays the trial license serial number or the activation

serial number if the product has been activated in the past.

l Expiration Date: Displays the date when the activation will expire, or the

current date if the product is not activated.

l End-User License Agreement - Appears only when loading a license file:

l License: This box displays the EULA. Please note that this agreement is leg-

ally binding.

l I agree: Select to accept the EULA. This option must be selected to install

the license.

l I don't agree: Select if you do not accept the EULA. You cannot install the

license if this option is selected.

l Load License File: Click to browse to the Connect license file (.olconnectlicense),

once it has been received.

l Install License - Active only when a license file is Loaded: Click to install the

license and activate the software.

l Close: Click to cancel this dialog.

Even if a license file has been Loaded, it will not be installed if this dialog is Can-

celled before the Install License button was clicked.

Requesting a license
After getting the Magic Number, a license request must be done for both OL Connect (with

the Enterprise version: for both Master and Extension Servers, if using a Clustered envir-

onment) and Workflow:

l Customers must submit their Magic Number and serial number to Upland Objectif

Lune via the Web Activations page: http://www.objectiflune.com/activations. The OL

Customer Care team will then send the OL Connect license file via email.

l Resellers can create an evaluation license via the Upland Objectif Lune Partner Portal

by following the instructions there: http://extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations

team.

Accepting the license will activate it, after which the OL Connect services will need to be

restarted. Note that in some case the service may not restart on its own. To resolve this

issue, restart the computer, or start the service manually from the computer's Control

Panel.
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Activating OL Connect Workflow
OL Connect Workflow uses the same licensing scheme as OL Connect. There are two ways

of activating the license for Workflow after saving it to a suitable location:

l If only OL Connect Workflow is installed, double-click on the license for the OL Con-

nect Workflow License Activation dialog to open. Applying the license here activates

all of the Workflow components.

l If you have both OL Connect Workflow and OL Connect installed, it will not be possible

to double-click on the license file as this will always open the OL Connect Activations

Tool. Instead, open OL Connect Workflow manually and apply the license through the

activations dialog within.

Activating OL Connect
To activate OL Connect, simply save the license file somewhere on your computer where

you can easily find it, such as on your desktop. You can then load the license by double-

clicking on it, or through the OL Connect Software Activation tool.

Activating the OL Connect license requires the user to have local Windows Administration

rights.

l Using a user profile that has local Windows Administration rights, open the Start Menu

l Click on All Programs, then browse to the Objectif Lune folder.

l Run the “OL Connect Software Activation” tool.

l Click the Load License File button, and browse for the .olconnectlicense file you

received from Upland Software, Inc..

l Read the EULA and click the I agree option to accept it.

l Click Install License to activate the license. The license will then be registered on the

computer and you will be able to start using the software.

Caution: After installation message will appear warning that the Server services will

need to be restarted. Just click OK to proceed.

Reactivating your license
You will need to request a new license if:

l The magic number has changed on the workstation the license is activated. The

magic number can change following hardware updates or updates of the operating

systems. When that happens, the software prompts you to enter a valid activation
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code.

l You are transferring the license to a new workstation.

As a customer, log in at the Web Activation Manager with your email address, customer ID

and password to reactivate your license. For further instructions, read the Web Activation

Guide (available for download from the Web Activation Manager).

If you are a reseller/partner:

1. Login at https://extranet.objectiflune.com/index.aspx.

2. Click “Reseller Licenses”.

3. Go to the “Request an NFR” section; select the product from the drop-down list, click

“Select license”.

4. Enter the new Magic Number and click Submit. You will receive an email shortly con-

taining your activations file.

Migrating to a new workstation
The purpose of this document is to provide a strategy for transferring a OL Connect (and/or

Workflow) installation to a new workstation.

Before installing the software
Before upgrading to a new version, even on a new workstation, consult the product's release

note to find out about new features, bug fixes, system requirements, known issues and

much more. Simply go to the product page and look for the "Release notes" in the Down-

loads area.

You should also consult the following pages for some technical considerations before

installing:

l "Network considerations" on page 14

l "Database Considerations" on page 9

l "Environment considerations" on page 12

l "Installation prerequisites" on page 21

l "Antivirus Exclusions" on page 7

Downloading and installing the software
In order to migrate to a new workstation, the software must already be installed on the new

workstation. Follow the "Installation and Activation" on page 20 guide to download and

install the newest version of OL Connect on the new workstation.
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If using Clustering in OL Connect Enterprise, please read the "Server Clustering" on

page 100 page of this documentation for more details relevant to the installation. 

Note that in a Clustering setup, both the Master and all Extensions must be upgraded to

the same version.

Backing up files from the current workstation
The first step in migrating to a new workstation would be to make sure all necessary pro-

duction files and resources are backed up and copied over to the new system.

Note: Although it is not necessary to convert all of your documents when upgrading to

the latest version, we strongly recommended doing so.

It is considered "Best Practice" to convert the documents to the version installed and

then re-send them to the Workflow Tools.

Backing up Workflow files

To save all Workflow-related files, backup the entire working directory. The default working

directory is:

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8

Here are a few important points when transferring these files:

l If you are upgrading to the latest version of Connect, it is recommended to open each

template in Designer, produce a proof making sure the output is correct. Then send

the template with its data mapping configuration, Job and Output preset files to Work-

flow by clicking on File > Send to Workflow...

l If you still use PlanetPress 7 legacy documents, PTK files can be imported by clicking

on the Workflow tool button at the top left corner of the Workflow tool interface. If

copying the PlanetPress Workflow 8 folder directly, it's important to delete any file

with the .ps7 extension so as to refresh the PostScript file for the new workstation.

Deleting the .ps7 files will make Workflow recreate them.

l The Workflow configuration file itself is named ppwatch.cfg, and is backed up with the

folders. However, it needs to be re-sent to the Service to be used. To do this, rename

the file to .OL-Workflow, open the file with the Workflow tool, and send the con-

figuration.

l Locate Custom Plugins (.dll) from the below folder on the old workstation and import

them onto the new workstation:

C:\Program Files (x86)\Common Files\Objectif Lune\PlanetPress Workflow

8\Plugins

To import the plugins:
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1. Start the Workflow Configuration Tool.

2. Click on the Plug-in Bar.

3. Click on the down pointing triangle under the Uncategorized group.

4. Select Import Plug-in and select the .dll file.

l Import any external scripts used by the Run Script plugin, making sure they reflect the

same paths as on the previous workstation

l Install any external application, executable and configuration files used by the

External Program plugin, making sure they reflect the same paths as on the previous

workstation

l Reconfigure local ODBC connections (i.e. create local copies of databases or recreate

required DSN entries).

l Backup and import other custom configuration files, Microsoft Excel Lookup files, mak-

ing sure they reflect the same paths as previously.

l Reinstall required external printer drivers and recreate all Windows printer queues

and TCPIP ports.

l On the new workstation if the "TCP/IP Print Server" service is running in Windows, it is

requested to disable that service so that it does not interfere with the Workflow

LPD/LPR services.

l Configure the Workflow services account as in the previous installation. If accessing,

reading and writing to network shares, it is recommended to use a domain user

account and make it a member of the local Administrators group on the new work-

station. Once the user account has been chosen:

1. Click on Tools in the Workflow Configuration menu bar.

2. Click Configure Services.

3. Select the user account.

l If required, grant permissions to other machines (Designer clients and other servers)

to send documents and jobs to the new server.

l Click on Tools in the Workflow Configuration menu bar.

l Click on Access Manager

l Grant necessary permissions to remote machines.

l Restart the Workflow Messenger service.
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l Reconfigure the Workflow Preferences as previously by clicking on the Workflow but-

ton at the top left corner and clicking on Preferences:

l Reconfigure the Server Connection Settings under Behavior > OL Connect.

l For PlanetPress Capture users, reconfigure the PlanetPress Capture options

under Behavior > PlanetPress Capture.

l Reconfigure each of the plugins, where necessary, under Plug-in as previously.

Capture OnTheGo users may want to enable the Use PHP Arrays option under

Plug-in > HTTP Server Input 1.

l Send the configuration to the local Workflow service.

Backing up Connect Resources

The following resources are used by Connect and can be backed up from their respective

folders:

l Job Presets (.OL-jobpreset):

C:\Users\[UserName]\Connect\workspace\configurations\JobCreationConfig

l Output Presets (.OL-outputpreset):

C:\Users\[User-

Name]\Connect\workspace\configurations\PrinterDefinitionConfig

l OL Connect Print Manager Configuration files (.OL-ipdsprinter):

C:\Users\[UserName]\Connect\workspace\configurations\PrinterConfig

l OL Printer Definition Files (.OL-printerdef):

C:\Users\[User-

Name]\Connect\workspace\configurations\PrinterDefinitionConfig

l OMR Marks Configuration Files (.hcf):

C:\Users\[UserName]\Connect\workspace\configurations\HCFFiles

Where [username] is replaced by the appropriate Windows user name.

Note: Also backup any Print Presets that are stored in different folders. As of version

2023.1 Job Presets and Output Presets are no longer automatically stored in OL Con-

nect's workspace folder: C:\Users\[User-

Name]\Connect\workspace\configurations.

Tip: Actually, the path may not begin with 'C:\Users', as this is language-dependent.

On a French system, for example, it would be 'C:\Utilisateurs'.
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Type %userprofile% in a Windows File Explorer and press Enter to open the actual

current user's home directory.

Other Resources

l OL Connect Designer Templates, DataMapper or Package files, copied from the folder

where they reside.

l All PostScript, TrueType, Open Type and other host based fonts used in templates

must be reinstalled on the new workstation.

l Import all dynamic images and make sure their paths match those in the old server.

l Make sure the new workstation can also access network or remote images,

JavaScript, CSS, JSON, and HTML resources referenced in the Connect templates.

Secondary software and licenses
The following only applies to specific secondary products and licenses that interact or are

integrated into the main product.

Image, Fax and Search Modules

l Reconfigure the Image and Fax outputs with the new host information.

l Import the Search Profile and rebuild the database in order to generate the database

structure required by the Workflow.

Capture

1. Download the latest version of the Anoto PenDirector.

2. Before installing the PenDirector, make sure the pen’s docking station isn’t plugged

into the server. Then install the PenDirector.

3. Stop the Messenger 8 service on the old and new server from the Workflow menu

bar: Tools > Service Console > Messenger > right-click and select Stop.

4. Import the following files and folders from the old server into their equivalent location

on the new server:

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\-

capture\PPCaptureDefault.mdb

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress

Watch\DocumentManager

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress

Watch\PGC
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5. If Capture was previously using an external MySQL or Microsoft SQL Server, recon-

figure the ODBC connection details as previously from the Workflow Preferences by

clicking on the Workflow button at the top left corner and clicking on Preferences,

then reconfigure the PlanetPress Capture options under Behavior >PlanetPress Cap-

ture > Use ODBC Database.

6. Start the Messenger 8 service on new server from the Workflow menu bar: Tools > Ser-

vice Console > Messenger > right-click and select Start.

OL Connect Send

l As of version 8.6 the Connect Send plugins are installed automatically with Workflow.

If you are using an older version, run the OL Connect Send Plug-in Installer on the new

Workstation to re-install the Connect Send plugins.

l Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup.

l Re-run the OL Connect Send printer driver setup on client system and select the

Repair option to point the clients to the new Server URL.

Configuring OL Connect
Configuring the Connect Engines

Any changes made to the Server preferences require the OLConnect_Server service to be

restarted to take effect.

1. Stop the OLConnect_Server service from Control Panel > Administrative Tools > Ser-

vices > OLConnect_Server > Stop.

2. Configure the Merge and Weaver Engines scheduling preferences as in the previous

installation

l Open the Server Configuration from:

C:\Program Files\Objectif Lune\OL Connect\Connect Server Con-

figuration\ServerConfig.exe

l Configure the DataMapper, Merge and Weaver engines preferences (see "Par-

allel Processing preferences" on page 93). As of version 2018.1 these preferences

include the minimum (Xms) and maximum (Xmx) memory utilization for the

Server, Merge and Weaver engines.

l Configure any other options for the Clean-up Service.

3. Now start the OLConnect_Server service
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Configuring the Server Extensions

In the case where the OLConnect MySQL is installed on the new Master Server, it is import-

ant to reconnect all Server Extension systems to the new Master Server.

Perform the following action on each Server Extension:

1. Stop the OLConnect_ServerExtension service from Control Panel > Administrative

Tools > Services > OLConnect_ServerExtension > Stop.

2. Open the Server Extension Configuration from:

C:\Program Files\Objectif Lune\OL Connect\Connect Server Exten-

sion\ServerExtension.exe

3. Click on Database Connection and configure the JDBC Database connection settings

so that the hostname points to the new Master Server.

4. Click on Scheduling and type in the location of the new Master Server.

5. Start the OLConnect_ServerExtension service.

Transferring software licenses

Once all the above resources have been transferred over to the new server, it is recom-

mended to thoroughly test the new system - in demo mode - with sample files under normal

production load to identify points of improvement and make sure the output matches the

user’s expectation.

Output generated at this point will normally bear a watermark which can be removed by

transferring licenses from the old server to the new one.

l To transfer Connect and Workflow licenses, the user is usually required to complete a

License Transfer Agreement which can be obtained from their local Customer Care

department.

l If you want to transfer your licenses to the new machine right away, you may ask your

local Customer Care department for a 30 day Transition activation code for your old

machine.

l Upgrades cannot be activated using the automated Activation Manager. Contact

your local Customer Care department.
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To apply the license file received from the Activation Team:

1. Ensure that all services are stopped on your old machine before activating and start-

ing the services on the new machine. Attempting to run the software with the same

license simultaneously will not only run into errors but it is a breach of our EULA.

2. Start the OL Connect Software Activation module:

C:\Program Files\Objectif Lune\OL Connect\Connect Software Activ-

ation\SoftwareActivation.exe

3. Click on Load License File to import the license.OLConnectLicense.

4. Start the Software Activation module on the Extension servers, where applicable.

5. Click on Load License File to import the above same license.OLConnectLicense.

6. Restart the OLConnect_Server service and restart the OLConnectServer_Extension

service on the Extension servers, where applicable.

7. The number of Expected Remote Merge and Weaver engines should now be con-

figurable in the Connect Server Configuration module (C:\Program Files\Objectif

Lune\OL Connect\Connect Server Configuration\ServerConfig.exe)

To apply the PlanetPress Capture License:

1. Open the Workflow Configuration.

2. Click on Help on the Menu Bar and click on PlanetPress Capture License manager to

import your license.

Uninstalling OL Connect from the previous workstation
It is recommended to keep the previous install for a few days until everything is completed.

However, once your transition is successful and complete, the OL Connect software must be

uninstalled from the original server. See "Uninstalling" on page 119.

Upgrading
This page provides information about Upgrading to OL Connect version 2023.2.

Upgrade information is detailed in the following pages:

l "Upgrading from previous Connect versions" on the facing page

l "Upgrading from PReS Classic" on page 60
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Upgrading from previous Connect versions
Users of Connect prior to 2022

Users of any version of OL Connect prior to 2022 should see the page "Pre-existing User

Data" on page 57 for information about exactly what data is saved or deleted.

Users of Connect prior to 2019.1

Users of Connect versions prior to 2019.1 should note that Update Client 1.2.40 is a pre-

requisite for both OL Connect 2019.1 and Connect Workflow 2019.1 installations. Only Update

Client 1.2.40 has the capacity to upgrade the OL Connect license to the newer format that is

required by the installers of those products.

If you do not have Update Client version 1.2.40 installed already, then the next time you run

your Update Client it will show that there is an update available of itself to Version 1.2.40 (or

later).

Simply click on the “Install” icon to initiate the upgrade.

For further details on how to upgrade the Update Client and update your Connect License

see the Update Client 1.2.40 Upgrade Guide.

Note: An incomplete uninstall of OL Connect before a reinstall or upgrade to a newer

version can lead to issues. See "Issue after erroneous or incomplete update or re-

installation" on page 110.

Before you upgrade

Always backup before upgrading

It is recommended that you always backup your existing OL Connect preferences before

upgrading to a new version. This will enable you to revert back to the previous version, in a

worst case scenario in which the new version introduces issues with your existing pro-

duction processes. Whilst the probability of such a worst case scenario is remote, it cannot

hurt to take some simple precautions, just in case.

For instructions on how to do so, please see "Backup existing Connect version" on the next

page.

Note: The scheduling settings were changed significantly in version 2019.2. Please

make sure to record your current scheduling settings for reference before proceeding

with an upgrade..
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Before installing a different edition

OL Connect is available in three different editions: Desktop, Professional and Enterprise.

Before upgrading or downgrading to a different edition, you must delete the license file

from: C:\ProgramData\Objectif Lune\OL Connect\licenses.

After installation, reactivate the software with your new license.

Recommendations

Before embarking on an upgrade, also follow these recommendations:

l Prior to updating your production environment, all updates to OL Connect/Workflow

should be performed in a development & test environment. This is both to test the

upgrade process and to test that your solution is still working as expected. Having a

development & test environment minimizes the risk of failure and business impact.

l Planning the upgrade:

o Perform the upgrade of your production server during off-peak hours when it

least impacts business.

o Prepare a rollback plan appropriate to your organization, which includes pro-

visions for reverting in the case of catastrophic errors. This can be as simple as

reverting to a snapshot or may be more involved on physical hardware.

o Anticipate at least 1 hour of downtime to provide enough time for the installation

and any rollback plan.

l Consult the "System requirements" on page 18 and "Installation prerequisites" on

page 21 before the upgrade to ensure that your environment is supported. If not,

upgrading is not recommended.

l When possible, disable your antivirus and anti-malware software during the upgrade

process. If it is not allowed by the security policies, please consider configuring the

proper exceptions:

o Connect exceptions

o Workflow exceptions

l Read the OL Connect Release Notes. They provide information regarding enhance-

ments in that release version (known issues, bug fixes, enhancements, new features,

etc.)

Backup existing Connect version

It is recommended that you always backup your existing OL Connect preferences before

upgrading to a new version. This will enable you to revert back to the previous version, in a
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worst case scenario in which the new version introduces issues with your existing pro-

duction processes. Whilst the probability of such a worst case scenario is remote, it cannot

hurt to take some simple precautions, just in case.

Backing up a virtual machine

Backing up a virtual machine installation is relatively straight forward. Simply take a snap-

shot of the virtual machine instance, prior to upgrading. This would save all the localized

preferences and configurations.

Backing up a real machine

Backup these folders

l C:\ProgramData\Objectif Lune\OL Connect\.settings\ConnectHostScope

l C:\Users\[UserName]\Connect\filestore

l C:\Users\[UserName]\Connect\workspace\configurations

l C:\Users\[User-

Name]\Con-

nec-

t\work-

space\Designer\.metadata\.plugins\org.eclipse.core.runtime\.settings

l C:\Users\[User-

Name]\Con-

nec-

t\work-

space\Server\.metadata\.plugins\org.eclipse.core.runtime\.settings

Where [username] is replaced by the appropriate Windows user name.

Tip: Actually, the path may not begin with 'C:\Users', as this is language-dependent.

On a French system, for example, it would be 'C:\Utilisateurs'.

Type %userprofile% in a Windows File Explorer and press Enter to open the actual

current user's home directory.

Note that the installer is designed to keep these folders/files intact. Backing them up is

simply a precautionary measure.

Additionally, these are only the folders that are natively managed by the installer. Back up

every custom location/resource that may be important for the functionality of your solution.
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Backup your database

If you want to be completely thorough and be able to exactly replicate your existing system,

you should also backup your existing Connect database.

If the default (pre Connect 2022.1) MySQL database were being used as the Connect back-

end database, we would recommend the MySQLDump tool be used for this. See for details

on this utility program: mysqldump (https://dev.mysql.-

com/doc/refman/5.7/en/mysqldump.html).

Pre-existing User Data

The following scenarios display what happens to pre-existing User Data in a Connect

upgrade.

Note: In regards to the MySQL (Connect version 2021.2 and earlier) or MariaDB (Con-

nect version 2022.1 onwards) entries: these are only applicable if the OL Connect data-

base component was installed in a previous Connect installation.

Scenario 1: Upgrading from Connect 2021.2 or earlier with Remove User Data CHECKED

l In all cases:

l Files and folders are removed from the user data folder C:\User-

s\<connectUser>\Connect , where <connectUser> is the user that installed OL Con-

nect.

l Files and folders are removed from the following data folders:

l C:\ProgramData\Objectif Lune\OL Connect\.settings

l C:\ProgramData\Objectif Lune\OL Connect\CloudLicense

l C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs

l C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

l Files are removed from the root of the data folder C:\ProgramData\Objectif Lun-

e\OL Connect\.

If the folder is empty following this (i.e. no license or user folders were present)

then the C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

l License files as well as any content not listed above but found in the C:\Pro-

gramData\Objectif Lune\OL Connect\ folder remain untouched.

l Additional cases:
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1. If MySQL was previously installed as an OL Connect component AND the data-

base contains some user-defined schemas:

n The native OL Connect schema is removed from the MySQL database.

n The MySQL database files (C:\ProgramData\Objectif Lune\OL Con-

nect\MySQL) are kept intact, as user-defined schemas mean that the user

did not have only the OL Connect native schema content in their database.

n A message at the end of the upgrade will advise the user that some

non-OL schemas were found in the database, so the database files

were not removed.

2. If MySQL was previously installed as an OL Connect component AND the data-

base does not contain any user-defined schemas:

n The MySQL database files (C:\ProgramData\Objectif Lune\OL Con-

nect\MySQL) are removed entirely.

Scenario 2: Upgrading from Connect 2021.2 or earlier with Remove User Data UNCHECKED

l In all cases:

l The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is

the user that installed OL Connect) is retained, untouched.

l All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL

Connect remain untouched.

l If MySQL was previously installed as an OL Connect component:

l All schemas from the MySQL database are migrated to MariaDB, allowing the

user to continue using their database content normally.

NOTE: This might take some time during the installation, depending upon the

size of the existing databases.

l The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL)

are also kept intact.

Scenario 3: Uninstalling Connect 2022.1 or later with Remove User Data CHECKED

l In all cases:

l Files and folders are removed from the user data folder C:\User-

s\<connectUser>\Connect , where <connectUser> is the user that installed OL
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Connect.

l Files and folders are removed from the following data folders:

l C:\ProgramData\Objectif Lune\OL Connect\.settings

l C:\ProgramData\Objectif Lune\OL Connect\CloudLicense

l C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs

l C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

l Files are removed from the root of the data folder C:\ProgramData\Objectif Lun-

e\OL Connect\.

If the folder is empty following this (i.e. no license or user folders were present)

then the C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

l License files as well as any content not listed above but found in the C:\Pro-

gramData\Objectif Lune\OL Connect\ folder remain untouched.

l Additional cases:

1. If MariaDB was previously installed as an OL Connect component AND the data-

base contains some user-defined schemas:

n The native OL Connect schema is removed from the MariaDB database.

n The MariaDB database files (C:\ProgramData\Objectif Lune\OL Con-

nect\MariaDB) are kept intact, as user-defined schemas mean that the

user did not have only the OL Connect native schema content in their data-

base.

n A message at the end of the upgrade will be displayed, stating some

non-OL schemas were found in the database, so the database files

were not removed.

2. If MariaDB was previously installed as an OL Connect component AND the data-

base does not contain some user-defined schemas:

n The MariaDB database files (C:\ProgramData\Objectif Lune\OL Con-

nect\MariaDB) are removed entirely.

Scenario 4: Uninstalling Connect 2022.1 or later with Remove User Data UNCHECKED

l In all cases:

l The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is

the user that installed OL Connect) is retained, untouched.
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l All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL

Connect remain untouched.

l If MariaDB was previously installed as an OL Connect component:

l All schemas from the MariaDB database are kept, allowing the user to use those

database files if they reinstall the software.

Upgrading from PReS Classic
PReS Classic and OL Connect are very different products.

Whilst OL Connect provides considerably more options for email and web output, one need

not abandon existing PReS Classic print jobs. They can still be run through Connect Work-

flow, using the PReS Print Controls task.

Upgrading from PlanetPress Suite 6/7

Note: This document is intended for people that purchased OL Connect and were pre-

viously users of PlanetPress Suite version 6 or 7. They should already have their new

serial number(s) in hand and the OL Connect installers.

OL Connect embodies a true Production Print as well as an Interactive Business Com-

munication Solution.

This document provides information on the migration process and the requirements and

considerations for existing PlanetPress Suite users to upgrade to the latest generation of

our products.

What does OL Connect contain?

OL Connect is comprised of the following modules:

l OL Connect Workflow 2023.2. This is the natural evolution of PlanetPress Suite Work-

flow 7 (Watch, Office or Production).  OL Connect Workflow 2023.2 is very similar to the

PlanetPress Suite Workflow 7 version but contains a number of new features and has

the ability to run OL Connect jobs, as well as PlanetPress Suite, PrintShop Mail Suite

and PReS Classic documents.

l Imaging for OL Connect is available as an option. It contains:

l OL Connect Fax

l OL Connect Image

l OL Connect Search
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IMPORTANT: If you owned them, you must also upgrade your Imaging modules to

use the new version.

l PlanetPress Capture is still supported in OL Connect Workflow 2023.2 but only

with documents created with the PlanetPress Suite Design 7.

l OL Connect Designer. This is a design tool based on completely new technology. It is

not backwards compatible and therefore cannot open PlanetPress Suite Design 7 doc-

uments. If you want to continue editing those documents you can keep doing so in

PlanetPress Suite Design 7.

l OL Connect Server. This is the core of the Connect technology (see Connect: a peek

under the hood in the Online Help: https://help.uplandsoftware.com/objectiflune/en/ol-

connect/2023.2/Home.html). This module automates the merging of data with your

new templates and generates the output. It is required for OL Connect Workflow

2023.2 to handle templates created with the OL Connect Designer. It can be installed

on the same or a different machine as OL Connect Workflow 2023.2.

IMPORTANT: OL Connect does not contain the PlanetPress Design 7.

OL Connect does not need any printer licenses to print from OL Connect or PlanetPress

Suite. It can also print PrintShop Mail 7 and PReS Classic documents if these programs

are licensed.

You can keep everything you have

The first thing to know is that you can keep your current PlanetPress Suite Workflow 7 con-

figuration and your PlanetPress Suite Design documents. When upgrading to OL Connect,

they will remain functional.

Please note that PlanetPress Suite Workflow 7 and OL Connect Workflow 8 cannot run at

the same time. See "Information about OL ConnectWorkflow" on page 77 for information

about these limitations. The only exception is the PlanetPress Suite Design tool that you

can continue to use as it is not part of OL Connect.

OL Connect installation considerations

The PlanetPress Suite could run on a computer with a minimum of only 1GB of RAM avail-

able. The OL Connect Server with OL Connect Workflow 2023.2, by default, requires 8GB of

RAM, but if you intend on using the new OL Connect Designer on the same computer, you

should consider having at least 16GB of RAM available. See "System requirements" on

page 18.
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Distributed installation or not

You can decide to install OL Connect modules all on the same computer or have each mod-

ule on a different computer. Reasons for this could be:

l There is insufficient memory in the computer currently running OL Connect Workflow

2023.2 to also run OL Connect Server.

l You want to use a more powerful computer with more RAM and more cores to run the

Server to achieve maximum performance (see "Performance considerations" on

page 15).

What do I gain by upgrading to OL Connect?

When upgrading to OL Connect, PlanetPress Watch users receive key features of Plan-

etPress Office such as the following:

l Ability to input data from PDF

l Ability to print your PlanetPress Suite documents on any Windows printer (no need for

printer licenses)

l Ability to create standard PDF output from your PlanetPress Suite documents

l Even if you don’t recreate your existing PlanetPress Suite documents, you can easily

change your workflow to convert your output to PDF, then output them in PCL to any

device supporting it.

l The full version of PlanetPress Connect can open your company to the digital world by

enabling you to send HTML responsive emails as well as creating dynamic responses

and interactive web pages.

You can reuse the content of your existing documents and map it onto responsive

documents that can be sent by email in full HTML glory and/or make them available

as native HTML web pages using the latest CSS/JavaScript features.

Note: If you were a PlanetPress Production user, you retain all functionalities within OL

Connect Workflow 2023.2. These are automatically imported during the activation (see

below).

Create new documents and integrate them into your workflow at your own pace

You can start benefiting from the innovative technology of the new OL Connect Designer

right away by designing new documents, or re-doing existing ones at your own pace. You

can also now:
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l Use the new DataMapper to easily map any input data into a clean data model that

any designer person can use.

l Easily create documents with tables that spread over multiple print pages, respecting

widow and orphan rules, displaying sub-totals and totals properly.

l Have text that wraps around images.

Upgrade steps

1. To upgrade to OL Connect, the first step is to stop your PlanetPress Workflow services.

You can do so from the PlanetPress Workflow configuration tool or from the Windows

Service Management console.

2. Then, using the OL Connect setup, install the Designer and/or Server on the appro-

priate computers.

3. Then, using the OL Connect Workflow 2023.2 setup, install OL Connect Workflow

and/or OL Connect Image on the appropriate computers. (See "Installation and Activ-

ation" on page 20 for more details.)

Note: If Workflow installation finds that .NET 4.0 is not already installed, it will

install that version as part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation,

then .NET 3.5 must also be installed. This will need to be installed manually, as

.NET 3.5 is not included in the Workflow setup.

4. If you installed OL Connect Workflow 2023.2 on the same computer where you had

PlanetPress Suite Workflow 6 or 7, you can use the Upgrade Wizard to import your:

l PlanetPress Workflow:

l Processes configuration

l PlanetPress Suite compiled documents

l Service configuration

l Access manager configuration

l Custom plug-ins

l PlanetPress Fax settings

l PlanetPress Image settings

l PlanetPress Search profiles

l Printer activation codes
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l PlanetPress Capture database

l PlanetPress Capture pen licenses

l Custom scripts

l Content of your virtual drive

l PlanetPress Messenger configuration

5. If you installed OL Connect Workflow 2023.2 on a different computer, please see "How

to perform a Workflow migration" on page 69 for help importing all those settings, if

you wish to import them.

6. To launch the Upgrade wizard, open the OL Connect Workflow 8 configuration tool

and, from the Tools menu, launch the Upgrade Wizard.

IMPORTANT: Before you start this process, make sure you have a backup of your cur-

rent installation/computer.
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7. Then select your upgrade type:
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8. Then select the product from which you wish to upgrade:

9. If you selected to do a Custom upgrade, select the required options:
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10. Then finally review the log in the final dialog for details on how it went:
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11. After that you will need to get the activation file for your product.

To obtain your activation file, download the OL Connect installer from the Web Activ-

ation Manager (http://www.objectiflune.com/webactivationmanager/), follow the

instructions for the installation using the serial number provided to you. You can activ-

ate your license through the Web Activation Manager.

12. From now on, if you need to modify your PlanetPress Design documents, simply open

PlanetPress Design 6 or 7, edit your document and send the updated version to OL

Connect Workflow. In order to do that:

l If you have PlanetPress Design on the same computer as OL Connect Workflow

2023.2, you need to save the documents to PTK by using the “Send to” menu,

then "OL Connect Workflow”, and there use the “Save to file” button. Then, from

the OL Connect Workflow configuration tool, in the “Import” menu, select “Import

a PlanetPress Document” and select the previously saved file.

l If you have PlanetPress Design on a computer and OL Connect Workflow 2023.2

on another, you can simply use the “Send to” menu in the Designer and select

the OL Connect Workflow tool to which you want to send the PlanetPress Design

document.
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How to perform a Workflow migration

What do you need to consider when upgrading from PlanetPress Suite 7 to OL Connect

Workflow 2023.2 on a new computer?

Installing and Activating Workflow 2023.2 on a new computer

Points to consider:

l Before installing, be sure to read "Installation and Activation" on page 20. There you

will find detailed Connect Workflow installation steps as well as system requirements,

notes on license activation and much more.

l It is recommended you retain your existing PlanetPress Suite installation for a period

of time after the OL Connect Workflow 2023.2 installation. We recommend this par-

ticularly when undertaking migration from one to the other. Once the migration has

completed, you should uninstall PlanetPress Suite from your original installation. In the

meantime, a fresh installation of OL Connect will run for 30 days without requiring an

activation code, to simplify the migration process.

l Request new activation codes for your software licenses (License Transfer agreement

needs to be filled out and signed). Contact your local Activations Department. www.ob-

jectiflune.com/activations

l Please note that PlanetPress Suite Workflow 7 and OL Connect Workflow 8 cannot run

at the same time. See "Information about OL ConnectWorkflow" on page 77 for inform-

ation about these limitations. The only exception is the PlanetPress Suite Design tool

that you can continue to use as it is not part of OL Connect.

Printer Licences

If you are currently using Printer Licenses under PlanetPress Suite 7 and wish to continue

doing so in OL Connect Workflow 2023.2, there are a few ways in which you can reinstall

those printer activation codes onto OL Connect Workflow 2023.2. They are as follows:

l If you retained the .pac file (printer activation codes) from your previous installation,

then double click on that file from within your new computer, and the printers will get

activated.

If you did not retain the pac file, you can export a new printer activation code. This is

done from the PlanetPress Suite Designer Help > Printer Activation menu option.

When the "Activate a printer" dialog is launched, right click within it and select the

Export context menu option, then save the file on the new computer. Double clicking

Page 69

http://www.objectiflune.com/activations
http://www.objectiflune.com/activations


on the .pac file will then activate all of your printers on the new computer.

l Login to our Web Activation Manager (www.objectiflune.com/activations) using your

customer number and password to get your Printer Activation Codes.

l If you do not have access to the computer in which PlanetPress Suite was previously

installed, print a Status Page for each printer from your Connect Workflow 8 Con-

figuration. Do this via the Tools > Printer Utilities menu option. Select “Print Status

Page” and then select your printers from the list.

Email the Status Page(s) to activations@ca.objectiflune.com and you will receive a

.pac file in return, with which you can activate your printer(s).

Documents and Resources

PlanetPress Suite Documents and Resources

l Backup all your PlanetPress Suite Design documents from your old computer and

copy them onto the new computer. The files use the extension .ppX, where X is the ver-

sion number of the PlanetPress Suite that created the files.

The documents do not have to be in any specific folder.

l Back up the entire directory of: "C:\ProgramData\Objectif Lune\PlanetPress Suite

7\PlanetPress Watch\Documents".

This folder contains all the PlanetPress Design documents and compiled forms (*.ptk

and *.ptz).

Paste the files onto the new computer in the following folder:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Docu-

ments"

l Back up the latest .pwX (PlanetPress Workflow Tools Configuration) file, found here:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\".

Paste onto the new computer in the following folder:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\"

There are several ways you can import Documents into PlanetPress Workflow. They are as

follows.

1. In Connect Workflow go to File > Import > PlanetPress Document … and select the .ptk

document you wish to import.

These files will most likely be found in the Documents folder on the PlanetPress Suite

computer:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Documents"
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2. Copy all the PlanetPress Suite 7 Documents and Compiled forms (*.ptk and *.ptz) from

the Documents folder on the PlanetPress Suite computer and paste them into the equi-

valent folder on the Connect Workflow Computer.

The PlanetPress Suite 7 folder would be "C:\ProgramData\Objectif Lune\PlanetPress

Suite 7\PlanetPress Watch\Documents".

The OL Connect Workflow 8 folder will be "C:\ProgramData\Objectif Lune\PlanetPress

Workflow 8\PlanetPress Watch\Documents"

3. Use the File > Send To menu option in PlanetPress Suite Designer and select the OL

Connect Workflow 8 to which you want to send the PlanetPress Suite Designer doc-

ument.

This should work with PlanetPress Suite versions 6 and 7.

Make sure that ports 5863 and 5864 are not blocked by firewall on either machine.

Also make sure you add the PlanetPress Suite machine’s IP address to the permissions

list in Connect Workflow 8 from Tools > Access Manager.

Further information about Workflow Access Manager can be found here: Access Man-

ager.

Windows Operating System Steps:

l Install all the Windows printer queues from the old computer, making sure they are

named the same.

l If your existing documents referenced any local dynamic image resources in a folder

or in Local Host, make sure that you import them onto the new computer as well, or

make them available on a network accessible drive.

l Any special PostScript or TrueType fonts used will also need be installed on the new

computer.

l Verify that you have access to any other resources that the PlanetPress Suite used.

This includes network folders, printers, third party software and the like.
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Workflow Plug-ins

Back up any custom PlanetPress Suite Workflow configuration Plug-ins (.dll) and copy them

onto the new computer.

The PlanetPress Suite Workflow plug-ins folder can be found here:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Plugins".

Make sure that you copy only the custom plug-ins.

Alternatively, you can download custom plug-ins from http://-

planetpress.objectiflune.com/en/suite/resources/support onto the new computer.

Once you've copied your PlanetPress Suite Workflow configurations to Connect Workflow,

you can confirm their availability through the Plug-in Bar Uncategorized category. There

you will find all the Custom plug-ins that have been installed.

Missing plug-ins will be represented in Workflow steps through the use of a "?" icon. Such as

in the following image, which shows that the "TelescopingSortPlugin" is not installed.

To import a plugin:

1. Click on the popup control ( ) in the Plug-in bar.

2. Select Import Plugin

3. Browse to the location of the plug-in DLL file

4. Click on Open.

5. The new plug-in should appear in the Plug-in Bar Uncategorized category.

Configuring OL Connect Workflow

l Reconfigure any settings that may need to be applied to the PlanetPress Suite Mes-

senger and PlanetPress Workflow Tools LPD services using the Access Manager (see

https://help.uplandsoftware.com/objectiflune/en/olconnect-workflow/2023.2/Work-

flow/Interface/Access-Manager.html).
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l All PostScript and TrueType host based fonts must be reinstalled. Make sure you

restart the computer after this step.

l If necessary, reconfigure local ODBC connections. (i.e. create local copies of data-

bases or recreate required DSN entries)

l Manually install all external executables that will be referenced by the Connect Work-

flow processes in the configuration file. If possible, retain the local path structure as

used on the older installation.

l If the Windows "TCP/IP Print Server" service is running on the new computer, it is

recommended that you disable the Server so that it does not interfere with the Plan-

etPress LPD/LPR services.

l If you are using images from a virtual drive, copy the entire contents of "C:\Pro-

gramData\Objectif Lune\PlanetPress Suite 7\PSRIP" and paste them onto the new com-

puter here: "C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PSRIP".

l Make sure to set the user who will run the PlanetPress Services. This is done by going

into Tools/Configure services. The user will need to have local administration rights in

order to be able to run the services.

For more information, see Users and Configurations (https://help.u-

plandsoftware.com/objectiflune/en/olconnect-workflow/2023.2/Work-

flow/WorkflowServices/Users_and_Configurations.html).

l Once all these steps have been completed, you will need to import your configuration

file. Find the latest pwX file located on the old computer, if it is not already copied

across to the new computer. The default location on the old computer is “C:\Pro-

gramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\”.

On the new computer you will need to go to File > Import > Configuration Components.

Browse and find your file. If the file is not visible change the file type to *.pw7

PlanetPress Image, Fax and Search

l Reconfigure the PlanetPress Image and PlanetPress Fax outputs with the new host

information.

l You must import the Search Profile and rebuild the database in order to generate the

required database structure.

PlanetPress Capture

l If you have a Capture Solution, please see "How to perform a Capture migration" on

the facing page.
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How to perform a Capture migration

This page provides information on how to conduct a proper migration of a Capture solution.

For information about Capture see: http://capture.objectiflune.com/en/howitworks.

These steps must be executed after a proper Workflow Migration has been completed.

Instructions on how to do such can be found here: "How to perform a Workflow migration"

on page 69.

Failure to do so will result in unexpected problems.

Note: It is recommended that you first update your PlanetPress Suite to version 7.6

before cross-grading to OL Connect.

Using OL Connect Workflow 2023.2 on the same computer as PlanetPress Suite 7.6

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.

2. Install OL Connect Workflow 2023.2 on the same computer.

3. Do the following for both PlanetPress Suite version 7.6 and OL Connect Workflow 8.

a. Open Workflow Service Console. This can be done either via the Windows Start Menu,

or from within Workflow Configuration application (via menu option Tools > Service Con-

sole).

b. Select Messenger in the tree list, right click and select Stop from the context menu.

Note: These steps must be done for both PlanetPress Suite Workflow 7 and OL

Connect Workflow 8.

4. Copy the file PPCaptureDefault.mdb from this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"

to this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture"

and overwrite the existing database.

Note: Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several

other details were contained within the one single database. As of PlanetPress

Suite 7.6 a separate database has been used for the patterns alone (PPCap-

tureDefault.mdb).

5. Copy the contents of this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
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Watch\DocumentManager"

to this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Docu-

mentManager".

6. Copy the contents of this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"

to this folder:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

7. Restart the OL Connect Workflow 8 Messenger. To do this,

a. Open Workflow Service Console. This can be done either via the Windows Start Menu,

or from within Workflow Configuration application (via menu option Tools > Service Con-

sole).

b. Select Messenger in the tree list, right click and select Start from the context menu

options.

8. Contact your local Upland Objectif Lune activation team and transfer any Pen(s)

licenses across.

Using OL Connect Workflow 2023.2 on a different computer to PlanetPress Suite 7.6

Tip: It is safer to migrate outside high peak production since the Capture solution can-

not be run in parallel on two computers.

Once the Capture database has been transferred to the new computer, any update

made to the old computer will be lost unless the steps to migrate are reproduce again.

Once a Pen has been docked and the data transfer done, its memory is wiped, thus

rending the parallel mode very hard to produce. It is not impossible, but describing

how it can be done is beyond the scope of this migration article.

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.

2. Install OL Connect Workflow 2023.2 on new computer.

3. The Anoto PenDirector must be installed. It if is not, you can download it from

http://www.ob-

jec-
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tif-

lun-

e.com/OL/lib/Com-

mon/Downloads/PlanetPressCaptureResources/AnotoPenDirector.zip and then install

it.

Note: It is strongly recommended that you install the latest version of the PenDir-

ector.

Please use the link provided on the previous line.

Do not get any other version of the PenDirector from the Anoto website, as

they will not have been set up correctly for our Capture solution.

Note: Prior to installation, make sure you unplug the Pen docking station from

the USB port on the computer where you are about to install the Anoto PenDir-

ector.

4. Do the following for both PlanetPress Suite version 7.6 and OL Connect Workflow 8.

a. Open Workflow Service Console. This can be done either via the Windows Start Menu,

or from within Workflow Configuration application (via menu option Tools > Service Con-

sole).

b. Select Messenger in the tree list, right click and select Stop from the context menu.

Note: These steps must be done for both PlanetPress Suite Workflow 7 and OL

Connect Workflow 8.

5. Copy the file PPCaptureDefault.mdb from this folder on the PlanetPress Suite 7.6 com-

puter:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"

to this folder on the new OL Connect Workflow 2023.2 computer:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture"

and overwrite the existing database.

Note: Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several

other details were contained within the one single database. As of PlanetPress

Suite 7.6 a separate database has been used for the patterns alone (PPCap-

tureDefault.mdb).

6. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
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Watch\DocumentManager"

to this folder on the new OL Connect Workflow 2023.2 computer:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Docu-

mentManager".

7. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:

"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"

to this folder on the new OL Connect Workflow 2023.2 computer:

"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

8. Restart the OL Connect Workflow 8 Messenger. To do this,

a. Open Workflow Service Console. This can be done either via the Windows Start Menu,

or from within Workflow Configuration application (via menu option Tools > Service Con-

sole).

b. Select Messenger in the tree list, right click and select Start from the context menu

options.

9. Contact your local Upland Objectif Lune activation team and transfer any Pen(s)

licenses across.

Information about OL ConnectWorkflow
If you wish to use OL Connect Workflow (automation), you will need to install OL Connect

Workflow 2023.2 as well. Workflow 2023.2 is provided through a separate installer which is

available on CD or for download as follows:

l If you are a Customer, the installer can be downloaded from the Upland Objectif Lune

Web Activations page: http://www.objectiflune.com/activations

l If you are a Reseller, the installer can be downloaded from the Upland Objectif Lune

Partner Portal: http://extranet.objectiflune.com/

OL Connect Workflow can be installed in parallel on the same machine as an existing Plan-

etPress® Suite 7.x installation.

Note however:

l If both versions need to be hosted on the same machine, OL Connect Workflow 2023.2

must always be installed after the legacy PlanetPress® Suite 7.x installation.

l When uninstalling OL Connect Workflow 2023.2, you may be prompted to repair your

legacy PlanetPress® Suite 7.x installation.
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l If OL Connect Workflow 2023.2 has been installed alongside PlanetPress® Suite 7, Cap-

ture can no longer be used with Workflow 7.

The plugins are now registered uniquely to Workflow 2023.2 and the messenger for

Workflow 7 is taken offline. It is only then possible to use Capture from OL Connect

Workflow 2023.2.

l OL Connect Workflow 2023.2 and PlanetPress® Suite Workflow 7 cannot run sim-

ultaneously, since only one version of the Messenger service can run at a time. In fact,

no two versions of Workflow can be run simultaneously on the same machine, regard-

less of versions.

l It is possible to switch between different versions running by shutting down one ver-

sion's services and then starting the other. However, this is not recommended. There

are no technical limitations that prevent processes from previous PlanetPress Suite

Workflow versions (as far back as Version 4) to run on OL Connect Workflow 2023.2,

removing the need to run both versions.

For more information on the licensing of Workflow 2023.2, please see "Activating a License"

on page 43.
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Server configuration settings
This chapter describes configuring the OL Connect Server.

In the Enterprise edition of OL Connect you can install Servers on multiple machines, in a

Master/Client relationship. To see an overview of these Master/Client setups, please see the

Enterprise only "Server Clustering" on page 100 topic.

The Connect Server settings are maintained by the Connect Server Configuration utility

tool which is installed alongside OL Connect.

Connect Server Configuration can be launched from the Start Menu, as seen in the fol-

lowing screenshot:

The Connect Server Configuration dialog is separated into individual pages, where each

page controls certain aspects of the software.

The following pages are available:

l Clean-up Service preferences

l "Connection preferences" on the facing page

l "Security and Users Settings" on page 83 (only available in the Enterprise edition,

but not for Enterprise edition Server Extension (Client) installations)

l Database Connection preferences

l Engines preferences

l "Automatic Restart settings" on page 92 (only available in the Enterprise edition,

but not for Enterprise edition Server Extension (Client) installations)

Note: Automatic Restarts are controlled by the main server. Server Exten-

sion (Clients) are treated the same as local engines in regards to restart

timing.
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l Hardware for Digital Signing preferences

l Language preferences

l Logging preferences

l "Parallel Processing preferences" on page 93

Connection preferences
Background
The Connection preferences are a way to control precisely how to connect to the OL Con-

nect Server.

This preference page was added in Connect 2018.2 to simplify management of

HTTP communication with OL Connect. HTTPS communication options were then added in

OL Connect 2021.1.

These preferences allow Connect inter-engine communication to occur on an alternate

port, reducing the chances of inter-engine communication being starved of connections

when running on a system that processes very large numbers of HTTP/HTTPS connections.

In OL Connect Enterprise, the Connections choices available to you will be dependent upon

whether the installation is a Master (or standalone) installation or a Server Extension (Cli-

ent) installation.

For standalone and Master installations, see "Connection settings (standalone/Master)"

below.

For Server Extension (Client) installation see "Connection settings (Client)" on page 82.

Connection settings (standalone/Master)
l REST Services group. Use this to adjust the HTTP or HTTPS communication settings

for Connect.

l Port: Set the primary HTTP or HTTPS Server connection port number for Con-

nect.

l Protocol:  Select whether to use HTTP or HTTPS.

If HTTPS is selected, the following HTTPS specific options become available:

l Root certificate:  This is an optional selection. Use the Browse button to loc-

ate the appropriate root certificate file, if one is available.

Page 80

../../../../../Content/designer/Interface/Designer_Preferences.htm#Hardware_for_Digital_Signing
../../../../../Content/ServerConfig/Server_Language.htm
../../../../../Content/designer/Interface/Designer_Preferences.htm#Logging_Preferences


l Server certificate:  Use the Browse button to locate the appropriate server

certificate file. This is a mandatory selection.

l Private key:  Use the Browse button to locate the appropriate Private key

file. This is a mandatory selection.

l Private key Password:  Enter the Private key password.

l Confirm password: Re-enter the password, to confirm it was entered cor-

rectly.

Note: Enabling HTTPS for the primary REST Services connection requires

different ports be used for the internal connections (IPC and REST)

between Connect Server and its engines.

l Internal communication on separate ports checkbox:

Set the internal connection communication ports. These settings are purely for Con-

nect inter-engine communication.

It is recommended that this option be selected.

Note: If HTTPS were selected as the REST Services protocol, these internal Port

settings must be entered.

Note: Please note that local security settings (including firewalls) must be taken

into consideration when setting Port entries.

l IPC Port: Set the internal connection port number. This cannot be the same at

the primary REST Services port number.

l REST Port: Set the internal REST connection port number. This cannot be the

same at the primary REST Services port, or the IPC Port.

l Advanced group

l Maximum threads: Sets the maximum number of HTTP threads for processing

requests.

This entry should only be changed in consultation with OL.

l Maximum asynchronous tasks: Set the maximum number of requests that can

be executed simultaneously.

The default asynchronous task setting is twice the number of processing cores

available to the computer. This can be expanded, if the limitation is deemed a

bottleneck.
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Note: This does not limit the number of requests that can be received, just

how many are processed in parallel. Additional requests are buffered and

are processed as capabilities allow.

Connection settings (Client)
l Master Server group. Use this to set connection to OL Connect Master server. (OL Con-

nect Enterprise edition only.)

l Hostname: Set the device name for the OL Connect Master server.

l Port: Set the port number for the OL Connect Master server.

l Username: The account that the services use to login to the OL Connect Master

server. If the machine is on a domain, use the format domain\username.

l Password: Enter the password associated with selected username.

l Initial retry interval (secs): The retry interval when initially trying to connect (or

reconnect) to the OL Connect Master server.

l Prolonged retry interval (secs): The retry interval for trying to connect (or recon-

nect) to the OL Connect Master server after the initial retry limit period has been

exceeded.

l Initial retry limit (mins): How long the initial connection (or reconnection)

attempts should run for.

Buttons

The Connections preferences also provides you with buttons to :

l Test Connection. This button is available only on OL Connect (Enterprise edition)

Server Extension (Client) installations .

When the button is pressed an attempt is made to connect to the OL Connect Master

server, using the location, user name and password set in this preference page.

If the connection is successful, a confirmation message is displayed in the top area of

the preferences page.

If the test fails, a warning message is displayed in the top area of the preferences

page. Set logs for further information.

l Restore Defaults. This option restores the preferences to Defaults. This applies to the

current Preferences page only, but not other Preferences.

l Apply: This option applies the settings made within the current Preferences page, but

does not close the Preferences dialog.
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Security and Users Settings

Note: This option is only available in the Enterprise edition of OL Connect.

This dialog controls the security settings for external applications connecting to the OL Con-

nect Server, such as OL Connect Designer, OL Connect Workflow plugins, or scripts com-

municating through the REST API.

Caution: It is highly recommended to keep security enabled and change the password

on any server accessible from the web.

If these precautions are not taken, data saved in the server may be accessible from

the outside!

l Enable server security: Enable to add authentication to the REST server.

- When enabled, the username and password (which cannot be blank) of an author-

ized user must be entered in any remote OL Connect Designer that links to this Server.

See the Connect Servers preferences sub-section of the Designer Preferences dialog.

- When disabled, a username and password is not required to make REST request, and

tasks in OL Connect Workflow do not require them in the Proxy tab. Nor would a user-

name and password be required on any remote OL Connect Designer that links to this

Server.

l Session expiration time (mins): Select a session time (in minutes, between one minute

and one year) that the authentication stays valid for the requested process. This can

reduce the number of requests to the server since an authentication request is not

necessary during the session.

l Authorized Users table: The Table contains a list of all currently Authorized Users.

All required information is summarized in the table, which has buttons to the right

which allow one to Add ( ), Edit ( ) or Delete ( ) individual entries. Double clicking

on any entry in the table also launches the Edit dialog.

The options available in the Add/Edit dialogs are as follows: 

l Username: Enter the username for the server security.

l Roles: Check the roles that apply to the user.

l Data Handler: The user can start and stop operations, get results of oper-

ations, and view and handle data (except resources). This appears as

ROLE_DATA in the table.
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l Resource Handler: The user can manage resources like data mapping con-

figurations, templates, and print presets. This appears as ROLE_RESOURCE

in the table.

l Monitoring: Can monitor the server, but cannot see data, change server set-

tings, or modify resources.This appears as ROLE_MONITOR in the table.

l Password: Enter a password for this user for the server security. There are no

specific password requirements or restrictions.

l Confirm password: Re-enter the password assigned to this user.

Note: Existing client sessions are not affected by changes to authorized users. Clients

may only see the effect after their session expires.

Engine configuration

Note: The options available will differ, based upon whether your edition of OL Connect

is the Enterprise edition or Professional edition. Where the options differ, this is reflec-

ted in the text.

The Connect Server cooperates with different engines to handle specific tasks. A DataMap-

per engine extracts data from a data file. A Merge engine merges the template and the

data to create Email and Web output, or to create an intermediary file for Printed output.

The intermediary file is in turn used by a Weaver engine to prepare the Print output. A

Merge engine merges the template and the data to create an intermediary file for Printed

output. The intermediary file is in turn used by a Weaver engine to prepare the Print output.

(For more information see: Connect: a peek under the hood).

Settings for these engines are made in the Connect Server Configuration tool (see "Server

configuration settings" on page 79).

Connect allows for the parallelization of jobs. This means you can allocate 1 or more

engines to process jobs.

OL Connect Enterprise edition only: The number of each type of engine - on each machine

in a Server Clustering setup - is configurable, as well as the amount of Merge engines than

can work together on the same job (determined by job size: small, medium or large) and at

what maximum speed.

OL Connect Professional edition: The number of each type of engine is configurable, as well

as the amount of Merge engines than can work together on the same job (determined by

job size: small, medium or large) and at what maximum speed.
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The "Parallel Processing preferences" on page 93 allow you to control precisely how the OL

Connect Server handles jobs.

This gives you, as solution developer or application manager, full control of how to apply a

machine's power. For example, you can share the available resources to process multiple

jobs at once or allocate all resources to process one single job as fast as possible, or any-

thing in between.

OL Connect distinguishes 5 type of jobs:

1. Small Print

2. Medium Print

3. Large Print

4. Email

5. Web

OL Connect categorizes print jobs on the number of pages they will produce. What con-

stitutes a Small, Medium or Large job can be configured per server (see below, in "Alloc-

ating processing power to jobs" on page 89).

There is no distinction between small, medium and large jobs for Email and Web output.

This topic explains all of these settings and the principles behind them, and it provides

guidelines for letting the Server manage the workload in such a way as to achieve the

highest possible output speeds.

Factors to take into account are:

l Your license, which imposes a speed quota (see "Speed quota: Pages Per Minute" on

the facing page).

l The processing power of your machine. How many cores it has determines how many

engines can be launched (see "Launching multiple engines" on page 87).

l The size and number of jobs of one kind that need to be handled, sequentially or sim-

ultaneously. In other words, your use case. By allocating processing power to jobs of

different sizes you can make the setup match your usage situation (see "Allocating

processing power to jobs" on page 89).

Tip: Other ways to enhance performance are described in another topic: "Per-

formance considerations" on page 15.

Page 85



Speed quota: Pages Per Minute
The highest possible output speed depends first and foremost upon your license.

The maximum is 10,000 Pages Per Minute (PPM) with the Professional edition, and 80,000

PPM with the Enterprise edition.

Note: PPM in this case stands for Pages and emails and web pages Per Minute.

The number of engines that are allowed to operate in parallel to create the same type of

output are referred to as the Licensed task limit.

OL Connect Enterprise edition provides 64 Licensed tasks.

OL Connect Professional edition provides 8 Licensed tasks.

Several engines can create the same type of output in parallel.

One engine needs at least one free speed unit to be able to create output.

It is important to note that only output operations are limited by this quota.

l Weaver engines always require a Licensed task to run.

l Merge engines only require a Licensed task when creating Email or Web output.

Merge engines involved in a Print process don't need a Licensed task in order to run.

l DataMapper engines don't need Licensed tasks.

In situations where Print and Email and/or Web output are created at the same time, only

the Merge engines that create Email/Web output count towards the maximum number of

Licensed tasks for that type of output.

Spare speed units are distributed proportionally

Since the number of engines is configurable, and jobs may run concurrently, the number of

engines in use may not match the exact number of available Licensed tasks.

When there are more Licensed tasks than there are engines in use, the OL Connect server

distributes the speed units and the maximum 'pages' per minute to all running jobs in pro-

portion to the number of engines they are using.

Note: Output speed is the speed at which the output is created by the engine in ques-

tion. Data mapping and other steps in a production process are not taken into

account. The throughput speed is the speed of the entire production process. This will

always be lower than the output speed.
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Launching multiple engines
One single engine can only process a single job at a time and will run mostly single-

threaded.

In order to benefit from multi-core systems it is recommended that several engines run in

parallel.

As a rule of thumb, you will want to run one less engine in total on a machine than the sys-

tem has cores, leaving one CPU core free for the Connect Server and the operating system

to use.

Modern hardware typically has both full cores and hyper-threading or logical cores. The

logical cores should not be counted as a full core when determining how many engines to

use. As a guide, count logical cores for only 25%-50% of a full core.

For example: on an Intel i7 CPU that comes with 4 cores and 4 additional hyper-threading

cores, Windows Task Manager will show 4 cores and 8 logical processors on its performance

tab. On a CPU like this, 5 or 6 engines can be configured to run in parallel.

To configure the number of engines:

1. Open the Connect Server Configuration utility tool (see "Server configuration set-

tings" on page 79).

2. Under Parallel Processing, go to the Content Creation tab and set the number of

Merge engines for the various tasks.

3. Go to the Output Creation tab and set the Reserved Weaver (Output) engines.

See "Deciding how many engines of each type to launch" below.

4. Click Apply or Apply and Close.

It is advised that you do not configure more engines than can be backed by actual pro-

cessing power. This adds overhead while not adding processing power.

Deciding how many engines of each type to launch

When jobs run in parallel, different types of engines may run at the same time. It depends

on the usage situation which type of engines has the biggest impact on performance.

The more and the larger operations of a kind need to be performed simultaneously with

smaller operations, the sooner you will see a performance increase when using multiple

engines.

Merge engine

Generally, launching a relatively high number of Merge engines results in better per-

formance, as Merge engines are involved in the creation of output of all kinds (Print, Email
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and Web) and because content creation is relatively time-consuming.

DataMapper engine

Adding DataMapper engines might be useful in the following circumstances:

l When large data mapping operations have to be run simultaneously for many jobs.

l When frequently using PDF or XML based input. Particularly in the case of XML input

with large individual records.

l When the All In One plugin is used often in Workflow configurations and there are

more than two Merge engines running.

The OL Connect MariaDB database needs a fast storage system (SSD or other fast devices)

to be able to keep up with two or more DataMapper engines.

When the database is installed on a system with a slow hard drive, adding a DataMapper

engine may not increase the overall performance.

Weaver engine

Adding extra Weaver (Output) engine(s) might be useful when large Print jobs are to be run

simultaneously with smaller Print jobs.

Memory per engine

By default, each engine is set to use up to a predetermined amount of RAM. To make

optimum use of a machine's capabilities it might be useful to increase the amount of

memory that the various engines can use.

l DataMapper engines may perform better with greater memory when running jobs con-

taining a lot of data.

l For complex templates with a lot of pages per document, there is a chance that Merge

engines will run better with more memory.

l The maximum memory usage of a Weaver engine can be relevant for jobs with heavy

graphics; or for jobs that use Cut & Stack impositioning; or for jobs using particular

variables that entail page buffering (see Content variables).

The Maximum memory per engine setting is found in the Engines preferences.

These settings only control the maximum size of the Java heap memory that an engine can

use; the total amount of memory that will used by an engine is actually a bit higher.

Also keep in mind that the Connect Server and the operating system itself will need memory

to keep running.
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Allocating processing power to jobs
Which engine configuration is most efficient in your case depends on how Connect is used.

What kind of output is needed: Print, Email, and/or Web? How often? How big are those

jobs? Do they have to be handled at the same time or in sequence? Would it be useful to

give priority to small, medium or large jobs, and/or to jobs of a certain kind?

Depending on the answers to these questions, you can allocate processing power to jobs in

order to run them as fast as possible, and/or in the order of your preference.

The first step in this process is to define the size of small, medium and large jobs.

Job size

Connect lets you define job sizes by setting the maximum number of pages a job can have

and still be considered a small job, and what the minimum number of pages a job can have

in order to be considered large. Jobs that fall between the small and large jobs are medium

jobs.

Defining small, medium and large jobs is important, as you can assign additional resources

to jobs that are considered either medium or large, via the settings for Merge and Weaver

engines.

There is no recommendation regarding what number of pages constitute a small, medium

or large job. Job size is a relative concept: in a small service company a job may be con-

sidered large when it outputs 1,000 pages, whereas that same job in a large insurance com-

pany might be seen as small. This setting needs to be based on an assessment of the actual

(or expected) workload of Connect.

To set the job sizes:

1. Open the Connect Server Configuration utility tool (see "Server configuration set-

tings" on page 79).

2. Under Parallel Processing, go to the Output Creation tab and enter the maximum

number of pages in a small job.

3. Enter the minimum number of pages in a large job.

4. Click Apply or Apply and Close.

Medium jobs will be those that fall between the maximum pages of a small job, and the min-

imum pages of a large job.

The number of engines used for small, medium and large jobs is configurable (see below).
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Running a job as fast as possible

Number of parallel engines per Print job

Two or more engines of a kind can be combined to work on the same Print job. Generally

jobs will run faster with more than one engine, because sharing the workload saves time.

However, running one job with multiple engines reduces the number of jobs that can be

handled at the same time by that kind of engine, because there are only so many engines

(and speed units) available.

Note: When each individual record in a job is composed of a very large number of

pages, the Memory per engine setting and the machine's hard drive speed are prob-

ably more important than the number of Merge engines, since one record cannot be

split over multiple cores, or machines (Enterprise edition only) (see "Memory per

engine" on page 88).

Target speed per Print job

If a Print job of a specific size has more than one parallel speed unit assigned to it, that mul-

tiplies its speed, however it reduces the number of Print jobs that can be run sim-

ultaneously.

When no other Print output operations run at the same time, a single job will use all avail-

able speed, or the maximum target speed reserved for jobs of that size (see "Dividing pro-

cessing power over jobs" below).

To set a number of speed units per Print job:

1. Open the Connect Server Configuration utility tool (see "Server configuration set-

tings" on page 79).

2. Under Parallel Processing, go to the Output Creation tab.

3. Set the Target speed when running simultaneous jobs for small, medium and large

Print jobs.

4. Click OK or Apply.

Dividing processing power over jobs

There is a number of ways in which you can divide processing power over output operations

of a certain kind and/or size.

l By reserving engines for jobs of a certain kind (and size, in the case of a Print job).

Note that reserved engines cannot be used by any other type of job. This means there
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will be fewer engines to handle other jobs. Consequently, the other jobs may take

more time and may have to wait (or wait longer). However, if the server receives many

web requests then having engines reserved for HTML output can help performance.

l By reserving a number of parallel engines for Print jobs of a certain size (see "Number

of parallel engines per Print job" on the previous page). More parallel engines will

make them run faster, but they will have to wait (longer) if the required number of

engines isn't available when they come in.

l By specifying target speeds for simultaneous Print jobs of a certain size.

All of these engine configuration settings are found in the Parallel Processing Preferences:

1. Open the Connect Server Configuration utility tool (see "Server configuration set-

tings" on page 79).

2. Under Parallel Processing, check out the information contained in both Content

Creation and Output Creation tabs.

How the Server decides if a job can be handled

In summary, this is how jobs are handled when they can run in parallel.

l Whenever a job comes in, the number of engines to use is determined. (For Print jobs,

this is based on whether the operation is small, medium or large; see "Job size" on

page 89.)

l If there are enough reserved Merge engines for that type of job available then those

engines will be used.

l If there are not enough reserved Merge engines available, then any unreserved Merge

engine that is available will be used.

l If no, or not enough, Merge engines are available then the job will have to wait until

the required number of appropriate Merge engines becomes available.

The following limitations apply at all times:

l The maximum number of concurrent Merge engines working on jobs of the same kind

or size may not be exceeded.

l If no - or not enough - speed units are available for that type of output, the job must

wait.

Examples

Here are a few examples of use cases and settings that would be appropriate in such cases.
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Batch processing. In a batch processing situation, jobs don't have to be handled sim-

ultaneously. All jobs - whether they are big and small - are processed one after another.

Every job should be handled as quickly as possible. It is therefor recommended to assign

the maximum number of engines and target speeds to all jobs. Do not reserve engines for

certain jobs.

Web requests. In online communication, response times are critical. If the Server receives a

lot of Web requests, it should handle as many as possible, as quickly as possible, at the

same time. It is recommended to launch as many Merge engines as possible and to reserve

most of them for HTML output. The jobs will generally be small and can do with just one

Merge engine.

Mixed jobs that are processed in parallel. In a situation where small, medium and large

jobs can come in at any time and should be handled in parallel, the challenge is to find a

balance between how much power can be allocated to jobs (to minimize the time they cost)

and how long they can wait. No single job should require all of the processing power, unless

it is acceptable for it to have to wait until the maximum number of engines finally comes

available - and then all other jobs will have to wait.

Automatic Restart settings

Note: This option is only available in the Enterprise edition of OL Connect.

Note: This option is not available for Enterprise edition Server Extension (Client)

installations

It is considered good management to restart the OL Connect Engines periodically. This dia-

log provides the controls for scheduling OL Connect Engines restarts.

Automatically restart engines to safeguard system availability

l Time Limit checkbox: This enables engine restarts to be scheduled to occur either

after a specified period of time, or within a daily time window.

This means daily Engine restarts can be scheduled to run outside of production hours.

l Rolling restart checkbox: This sets the engines restarts to occur in a "rolling" fashion,

whereby each engine is stopped and restarted individually, one after the other.

Each engine is only stopped when the previously restarted engine is once again ready

to start processing.

l Restart method: Chose between restarting after a specified number of minutes

(Restart after interval) or within a daily time window (Daily restart in period).
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l Restart after (minutes): Only available if Restart after interval selected.

Specify the amount of minutes that the restarts are to occur after.

l Daily restart period begin: Only available if Daily restart in period selected.

Enter the daily start time for the time window in which automatic restarts will be

scheduled to occur.

l Daily restart period end: Only available if Daily restart in period selected.

The end of the daily time window in which the automatic restarts are scheduled to

occur.

Memory limit

Enter the memory limit for individual Engines. If any of these memory limits are exceeded,

an automatic restart of those Engine types will be triggered.

l Data Mapper Engine (MB): Enter the memory limit for Data Mapper Engine.

l Merge Engine (MB): Enter the memory limit for Merge Engine.

l Weaver Engine (MB): Enter the memory limit for Weaver (Output) Engine.

Parallel Processing preferences
The parallel processing preferences (previously referred to as Scheduling preferences, prior

to 2019.2) page provides the means to control precisely how the OL Connect and Connect

Server (Master or Client, with the Enterprise version of OL Connect) handles jobs that oper-

ate in parallel.

There is considerable difference between the preferences that are available in the Designer

Parallel Processing page and the Server Configuration Parallel Processing page.

l For the Designer specific preferences, see "Parallel Processing properties (Designer

Preferences)" below.

l For the Server Configuration specific preferences, see "Parallel Processing properties

(Server Configuration)" on page 95.

For additional information on how these preferences can enhance performance, see

"Engine configuration" on page 84 and "Performance considerations" on page 15.

Parallel Processing properties (Designer Preferences)
Preset selection (Designer Preferences)

Only the Custom setting is applicable to the Designer Preferences, so this option is always

selected and the field made read-only.
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Content Creation Tab (Designer Preferences)

A Tab with data that relates solely to Content Creation.

The options are:

l Total Merge engines configured read only display: This is a read only entry that shows

the total number of Merge engines available. To change this value, you must update

the Merge Engines in the Engines preferences page.

l Multi tasking group:

When starting a new Content Creation task, the task will immediately commence if

there is a Merge engine available. How many Merge engines to use is based on the

number of records in the input data.

Select from the following options:

l Optimize per task: This runs each task with as many Merge engines as needed

(until engines are exhausted).

Using this option means that Merge engines will not be reassigned when new

tasks come in.

This option is better suited for batch processing.

l Maximize simultaneous tasks: Merge engines will be reassigned from a running

task to new tasks when they arrive.

To accommodate as many tasks as possible, the server can dynamically reas-

sign Merge engines to new tasks as they arrive. Thus a running Content Creation

task need not block other tasks.

If multiple Merge engines are processing a task, an engine can be taken from

that task and reassigned to a new task.

As each task finishes, any freed up Merge engines get re-assigned back to still

running tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.

l Additional engine every (records) entry: This controls how many Merge engines

are used for a Content Creation task. It means that for every additional 'x'

records in the task, an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will

be assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines,

tasks with 201-300 get assigned 3 merge engines, and so on.
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Note: These entries aren't applied instantaneously. There is often a lag.

That is why you can reserve a specific number of engines for new jobs, in

the options below. Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied

number, not because it has been proven to have any significant value. It means

that on an average system (i.e., less than 10 Merge engines) any decently sized

task is allowed to use all Merge engines. It also assumes that using more than

one Merge engine for less than 100 records will probably not make a big enough

difference to throughput speed. Obviously, there are situations where these

assumptions will not apply.

Note: Currently, it’s only the print and PDF content creation tasks that use

multiple Merge engines.

Parallel Processing properties (Server Configuration)
These are the options that you will be presented with if the OL Connect Server was installed.

Whether options are available for selection on this page or not is entirely dependent upon

the Number of engines selection made in the Engines preferences page. If either of the

Merge Engines or Weaver Engines were set to a value beyond one, then options will become

available in this Parallel Processing properties page.

Preset selection (Server Configuration)

Choose from some common usage scenarios. The preset scenarios are:

l Default - Basic settings that are good for running most things. Single jobs have pref-

erence over multi-tasking, however.

l Batch Print - Best settings for processing jobs, one by one, in a sequential, first in first

out (FIFO) order.

l On demand Print - Best settings for processing many small print jobs simultaneously.

l On demand - Use when serving web pages, sending emails, and printing many on

demand jobs simultaneously.

l Connect Send - Settings optimized for use with Connect Send.

Connect Send needs a Merge engine available for on demand web pages, to be able

to process on demand print jobs (especially content creation), and have a Weaver

engine available for creating the production output.

l Capture on the Go - Settings optimized for use with Capture on the Go applications.

Capture on the Go needs on demand content creation for web pages (the forms),
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emails (notifications), and PDFs (persistent version of forms).

l Custom - where you can chose exactly where and how the engines are to be assigned.

Note: We would recommend basing any Custom settings on one of the preset

scenarios.

Select the preset that most closely matches your day to day needs, then tweak

those settings.

Only the Custom setting allows you to manually set where and how the engines are to be

assigned. If selected, then options for Content Creation and Output Creation will become

available under the two Tabs named thus.

Content Creation Tab (Server Configuration)

A Tab with data that relates solely to Content Creation.

The options are:

l Total Merge engines configured read only display: This is a read only entry that shows

the total number of Merge engines available. To change this value, you must update

the Merge Engines in the Engines preferences page.

l Multi tasking group:

When starting a new Content Creation task, the task will immediately commence if

there is a Merge engine available. How many Merge engines to use is based on the

number of records in the input data.

Select from the following options:

l Optimize per task: This runs each task with as many Merge engines as needed

(until engines are exhausted).

Using this option means that Merge engines will not be reassigned when new

tasks come in.

This option is better suited for batch processing.

l Maximize simultaneous tasks: Merge engines will be reassigned from a running

task to new tasks when they arrive.

To accommodate as many tasks as possible, the server can dynamically reas-

sign Merge engines to new tasks as they arrive. Thus a running Content Creation

task need not block other tasks.

If multiple Merge engines are processing a task, an engine can be taken from

that task and reassigned to a new task.

As each task finishes, any freed up Merge engines get re-assigned back to still
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running tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.

l Additional engine every (records) entry: This controls how many Merge engines

are used for a Content Creation task. It means that for every additional 'x'

records in the task, an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will

be assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines,

tasks with 201-300 get assigned 3 merge engines, and so on.

Note: These entries aren't applied instantaneously. There is often a lag.

That is why you can reserve a specific number of engines for new jobs, in

the options below. Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied

number, not because it has been proven to have any significant value. It means

that on an average system (i.e., less than 10 Merge engines) any decently sized

task is allowed to use all Merge engines. It also assumes that using more than

one Merge engine for less than 100 records will probably not make a big enough

difference to throughput speed. Obviously, there are situations where these

assumptions will not apply.

Note: Currently, it’s only the print and PDF content creation tasks that use

multiple Merge engines.

l Reserve engines for on demand tasks group checkbox:

Reassigning engines is not instantaneous when a new task arrives. To avoid inef-

ficiencies, Merge engines will first finish work on their current selection of records,

before being reassigned. Reserving engines better ensures that on demand tasks get

picked up right away, but it also means that less engines will be available for large

tasks.

The total amount of Merge Engines available for selection here must be set in the

Engines preferences page.

Select from the following options:

l Email (engines): Set the amount of Merge engines to reserve for Email jobs.

l Web (engines): Set the amount of Merge engines to reserve for Web based jobs.
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l Print and PDF (engines): Set the amount of Merge engines to reserve for Print

output jobs.

l Merge engines available for any task: A read only value that shows how many

Merge engines remain available for selection.

l On demand task size limit (records): An on demand task is a task that has

someone (or something) waiting for it to finish, so these typically need to finish

“as soon as possible”. Often these are single documents but not necessarily

always.

This option allows you to designate what a Content Creation on demand task is,

based upon the number of records.

Output Creation Tab (Server Configuration)

A Tab with data that relates solely to job Output Creation.

If only the single Weaver Engine is configured in the Engines preferences page, then this

whole tab will be disabled.

l Licensed speed limit (pages per minute): This read only entry shows the current

license speed limitations, in pages per minute. The speed limitations are determined

by your OL Connect license.

This information is to help you choose what settings would make sense when assign-

ing the “Target speed” values later in the Tab.

l Licensed tasks limit: This read only entry shows the current license task (or job) lim-

itations.

Note: The terms "job" and "task" can be used interchangeably.

l Total Weaver engines configured: This read only entry shows the total number of

Weaver engines available. To change this value, you must update the amount of

Weaver Engines in the Engines preferences page.

Job sizes group:

These two settings allow you to define what type of jobs are to be considered Small jobs

and what types are to be considered Large. Any job that falls between these two settings (if

there is a gap between the two) will be considered a Medium job.

Small job max (pages): Enter the maximum number of pages a job can have and still be

considered Small.

Large job max (pages): Enter the minimum number of pages a job must have before it is

considered to be a Large job.
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Reserved engines group:

These settings allow you to reserve some Weaver (Output) engines for small and medium

Output Creation tasks. This it to prevent large jobs from using all available engines and

blocking small or medium jobs from running. Since Weaver engines cannot switch tasks,

such behaviour can only be achieved through reserving engines for small and/or medium

jobs.

Engines may be reserved both for small, and for medium sized jobs. Engine reservations are

not required for either though.

l Small job (engines): Optionally enter the number of Weaver engines you wish to

reserve for Small jobs.

To make sure large batch jobs get sufficient speed during Output Creation, set a

lower target speed for small jobs, this will automatically allow more for the large and

medium jobs.

l Medium job (engines): Optionally enter the number of Weaver engines to reserve for

Medium jobs.

l Total Weaver engines configured: This read only entry shows the number of Weaver

engines still available. This is the Total engine count, minus the number of engines

assigned to both Small and Medium jobs.

To change this value, you must update the total amount of Weaver Engines in the

Engines preferences page.

Target speed when running simultaneous jobs group:

If a single Output Creation task is running, it will be run at the full speed in the license. But

when multiple tasks run in parallel, this speed has to be divided between them. By default,

the maximum speed will be divided equally between tasks.

Use these settings to override what speed (in Pages Per Minute) should apply for each type

of job. This allows you to prioritize one or more type of job above the others. For example, if

your production process normally handles lots of small jobs, you might want to provide the

smaller jobs greater speed (throughput) than the less frequent Medium and Large jobs.

But if there are so many small jobs that they start limiting the throughput of larger jobs? If

there is always at least one small job running, then the maximum speed for the larger job

will stay at half of the licensed limit. In this case, you might want to increase the target

speed for Large jobs.

There are no hard and fast answers as to what settings will work best. It will likely be a
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matter of trial and error. But many sites will not need to change speed settings at all.

The options are:

l Small job (PPM): Enter the target speed for Small jobs, in Pages Per Minute (PPM).

l Medium job (PPM): Enter the target speed for Medium jobs, in Pages Per Minute (PPM).

l Large job (PPM): Enter the target speed for Large jobs, in Pages Per Minute (PPM)

The entire licensed speed limit will always be distributed among jobs when running jobs sim-

ultaneously.

After assigning a target speed, any remaining licensed speed will be distributed throughout

any simultaneous jobs by a ration of the target speed.

Some general rules of thumb to apply when distributing target speed:

n Do you need to change speeds? In many cases there will likely be no need to change

the target speed.

n The target speed is not a guaranteed actual speed, but a speed limit that the engine

is allowed to exceed in order to utilize the licensed speed.

n When changing the target speed, don’t be overly precise, you are unlikely to get that

exact value anyway. It will likely be a matter of trial and error.

n As long as you don’t overdo it, the actual speed limit for a task will usually be higher

than the target speed.

n If there is a chance of not getting the target speed, you will see a warning in the pref-

erence page. This is just a warning, and nothing will break if you choose to ignore it.

Buttons

The Parallel Processing preferences also provides you with buttons to :

l Restore Defaults. This option restores the preferences to Defaults. This applies to the

current Preferences page only, but not other Preferences.

l Apply: This option applies the settings made within the current Preferences page, but

does not close the Preferences dialog.

Server Clustering

Note: This option is only available in the Enterprise edition of OL Connect.
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Note: This option is not available for Enterprise edition Server Extension (Client)

installations

Server Clustering, only available in the Enterprise edition of OL Connect , enhances the pro-

cessing capabilities of OL Connect Server by load-balancing jobs between the main Server

module (master) and one or more Server Extension installations.

Setting up Server Clustering requires two or more installations of OL Connect on separate

machines.

The Master server is setup by installing the OL Connect Server module during the "Install-

ation Wizard" on page 24, while any Server Extension (Client) Servers are setup by installing

the OL Connect Server Extension module instead.

Quick Howto
1. Install the Master server (OL Connect Server module), making sure to select the Mari-

aDB module.

2. Grant access to the MariaDB root user for the appropriate IP range on the Master

server.

3. Restart the MariaDB Service on the Master server.

4. Install Server Extension (Client) servers (OL Connect Server Extension module).

5. Install the license on the Master server.

6. Set the preferences for the engines (see "Engine configuration" on page 84) on both

the Master and Server Extensions (Clients).

7. Install the license on the Server Extension (Client) servers.

8. Restart the Master server then, once restarted, restart the Server Extension (Client)

servers.

What if MariaDB is not on the Master server?

It is possible to setup clustering with a MariaDB instance that is on a Server Extension (Cli-

ent) server instead of on the master. In this case, the Server Extension (Client) must be

installed with the MariaDB modules, the MariaDB instance configured (steps 2-4 above)

then the master and other Server Extensions can be installed. The remainder of the instruc-

tions remain the same.

It is also possible to setup clustering with MariaDB/MySQL being installed completely sep-

arately from OL Connect, such as using an existing MariaDB/MySQL instance. For such

cases, the instructions for the bind address must be followed, but the user does not have to

be root. A user for the database must be created and have full access (GRANT ALL
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PRIVILEGES) to a database called "objectiflune" that can be created before Connect is

installed.

Binding and Root access on the Master server

l The MariaDB server's binding must be set to accept connections from the Server

Extension (Client) servers.

To do this, open C:\ProgramData\Objectif Lune\OL Connect\MariaDB\my.ini in a

text editor and change the line bind-address= 127.0.0.1 to bind-address-

s=0.0.0.0.

Once the changes have been made and saved you need to restart the MariaDB ser-

vices.

l Access must be granted to the root user on the IPs from which the Server Extension

(Client) server will connect.>

l Open a Command Prompt in the following folder:

C:\Program Files\Objectif Lune\OL Connect\MariaDB\bin

Note: Navigate to the folder, SHIFT+Right-click and select "Open a com-

mand prompt here"

l Type in the following command to connect to the database, where <password> is

your MariaDB password. (This password is the MariaDB root password entered

as part of Connect installation process. It had to be at least 8 characters long

and contain mixed case characters, numeric digits and a punctuation char-

acter):

MariaDB --user=root --password=<password> objectiflune

You should see the prompt become MariaDB>.

l Here, type the command to allow the "root" user to be accessed from a specific

IP subnet range.

For example, to accept communication on 192.168.*.*, use:

GRANT ALL PRIVILEGES ON objectiflune.* TO

'root'@'192.168.0.0/255.255.0.0' IDENTIFIED BY 'password';, where

password is the one provided during installation. ( ref: http://dev.mysql.-

com/doc/mysql-security-excerpt/5.5/en/adding-users.html)
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Tip: IP Subnets understanding is beyond the scope of this documentation. If you want

to learn more, please see the Subnetwork article on Wikipedia (http://en.wiki-

pedia.org/wiki/Subnetwork).

Clustering Preferences and Setup
When Server extensions are installed and connected to a Master, the following options and

settings change in availability or behaviour:

l The Clean-up Service requires special configuration on Clustering setups:

l Clean-up service should not run simultaneously on all machines (staggered

clean-up).

Doing so may cause jobs not to be processed since all servers are busy.

l Only the machine where the MariaDB/MySQL Server product is installed should

attempt to clean-up database items. Essentially servers that do not have Mari-

aDB/MySQL should only run Orphan File Clean-up.
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Known Issues
This page lists important information about issues that apply to OL Connect 2023.2.

Additional Content font selection issue
The Additional Content (text and barcode) available in the Advanced Print Wizard does not

support localised Chinese, Japanese and Korean (CJK) font family names, even they are

available through the font selector.

This will be addressed in a future release.

Performance not scaling as expected
When you have a machine with a lot of CPU cores and you configure Connect to run many

Merge Engines (8+) simultaneously, the performance can be less than expected.

It has been reported that the CPU is not fully utilized and the performance per Merge

Engines actually goes down, the more Merge Engines you add.

This will be addressed in a future release.

Errors running OL Connect database cleanup
Due to inconsistent handling of date literals under different database login languages,

errors can happen in the database cleanup if the OL Connect Server installation is setup as

follows:

1. SQL Server is used as the database

2. The SQL Server login account being used for the Connect Server connection is set to

“British English” in the language preferences

3. Partitioning is turned on in the OL Connect Server cleanup preferences

The workaround is to switch the login to use “US English” (or “English” depending on the

SQL Server version).

It is recommended you create a specific login/user for the OL Connect database, so that

other databases running on the same server and accessed with the original login name are

not affected.

The issue is fixed in OL Connect 2024.1.
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Space in data field name can cause incorrect barcode
When you add a barcode for a data field that has a space in the name, the space is not

automatically escaped. This can lead to incorrect data in the barcode. The workaround is to

put square brackets around the field name in the barcode expression. See Adding a Bar-

code.

This issue is fixed in version 2024.1.

Editing in Preview mode breaks translation feature
Editing a section in Preview mode with the Evaluate Handlebars expressions option

enabled breaks the translation feature.

The solution is to not edit the section in Preview mode, or to disable the option.

Absolute positioned boxes cannot be moved
Absolute positioned boxes on a master page in a template created with an earlier version of

OL Connect (2023.1 or older) cannot be moved when the template is opened in version

2023.2.

The workaround is to go to the Source view and remove the anchored attribute from the

absolute positioned element. Then it can be moved in the Design view.

This issue will be fixed in version 2024.1.

Translation issue
Templates cannot be automatically translated if the "Plural-Forms" header is missing from

the translation file (.PO) for the target language.

The solution is to add the header. This can be done in two ways.

Use the newest version of POEdit and in the Translation Properties check the option: "Plural

forms: Use default rules for this language".

Or manually add the Plural-Forms line to the header of your .PO file. For example, if the tar-

get language is French, add: "Plural-Forms: nplurals=2; plural=(n > 1);"

You can look up the correct plurals header for your target language at www.-

docstranslatehouse.org.

This issue is fixed in OL Connect version 2024.1.

Unicode Variation Selectors issue
The Designer and Merge engine can crash when a document or input data contains a

Unicode Variation Selector. A variation selector is a special Unicode character in the range

of U+FE00 - U+FE0F that indicates which variant of the previous character should be used.

The issue has so far only occurred on Windows 11 systems and will be fixed in a later release.
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Font names containing 'undefined' characters
In PDF output, font names may contain 'undefined' characters when a Weaver engine has

failed to choose the correct encoding for font names.

This issue is fixed in version 2024.1.

ODBC drivers do not all work with OL Connect
ODBC drivers do not all work with Java applications.

Since OL Connect is a Java application, it is strongly recommended you use JDBC instead.

Incorrect colors in print preview
Colors are not displayed correctly in previews generated by the Advanced Print Wizard.

Concatenating PDF files is slower
As of OL Connect 2022.1, concatenating PDF files is significantly slower than in previous ver-

sions. This is visible in the Merge PDF Files and Send to Folder plugins with the Concatenate

files option enabled, and when using the Pages.InsertFrom() functions of the AlambicEdit

script API.

This is due to upgrading to the Adobe PDF Library version 18.0.3, which has improved the

reliability of the PDF merging process at the expense of speed.

Account permission issues
If you install and run OL Connect Designer and Server under different user accounts (for

example, install under User1 and run Designer as User2), account permission issues may

occur.

It is recommended that you install and use OL Connect Designer and Server under the

same user account.

Issues converting some images from PCL to PDF
Problems have been reported with the conversion of some images, from PCL files to PDF out-

put.

In some, the image is replaced with a grey box. In others, the images convert, but with a ver-

tical line added to the edge of the image.

This is due to an issue with a third party library which will be addressed in a future release.

Expressions not supported in HTML attributes
In sections, Handlebars expressions in HTML attributes are not supported.
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Master Page not affected by style rules for <body>
In the output, content in Master Pages is affected by style rules targeting <html>, but not by

style rules targeting the <body> element. This is because in the output, they are placed out-

side the <body> of the section to which they are applied. When editing a Master Page, style

rules targeting the <body> element will work, because the Master Page is not currently

applied to a section, but they will have no effect in the output.

JDBC connection issue
In OL Connect version 2022.2, the SQL Server driver has been updated to version 10.2.0.jre11.

As opposed to preceding versions, this driver by default attempts to connect to a JDBC

database with encryption enabled if the encrypt parameter is missing from the connection

string. This might break existing JDBC connections, particularly those defined in scripts

and in the Database Wizard's 'Advanced Mode'.

To instruct this driver to not use encryption, the ";encrypt=false" parameter needs to be

present in the connection string.

Installer issues
The new 2022.1 installer has some minor issues that will be fixed in a subsequent release.

The issues are:

l After installation, the "recent files" list is cleared and the measurement units are reset

from 'cm' to 'inch'.

l When updating from earlier 2022.1.x versions the bundled MariaDB connection settings

are reset.

Dynamic tables causing issues
In some specific circumstances the dynamic tables feature does not behave correctly. The

following scenarios should be avoided to prevent subsequent issues with the template:

l Using page-break-before:always on the top TR of a TBODY causes a problem and

results in a pagination error

l It is possible to specify conflicting attributes on a TR element:

l page-break-before:always or page-break-after:always combined with

data-repeat

l page-break-after:always combined with page-break-before:avoid on the

next sibling TR (or similar combinations)

These issues will be addressed in a later OL Connect release.
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DataMapper: Automatic Date/Time does not work with certain negative
UTC time zone offsets
The new "Automatic" date parsing option in the DataMapper cannot parse dates with neg-

ative UTC time zone offsets of non-zero minutes.

For example: 2021-03-01T10:00-03:00 will work, but 2021-03-01T10:00-03:30 will not.

Positive time zones with non-zero minutes (such as +10:30) are unaffected.

The negative time zone offsets affected are: UTC -02:30; -03:30; -04:30 and -09:30

This issue will be fixed in a later release. In the meantime, the workaround is to use

“Custom” or “ISO8601” date parsing options in DataMapper.

CSS inlining colour values now converted to RGB
As of OL Connect 2021.2 when using the CSS inlining mode "Apply CSS properties on ele-

ments" for emails, all colour values are now converted to RGB, rather than to HEX.

Issues running Connect on Hyper-V 9.0
Some customers have reported difficulties running OL Connect on Hyper-V version 9.0. In

some instances OL Connect cannot install and in others the OL Connect Server service

sometime stops with a signature error.

To resolve these issue we recommend downgrading to Hyper-V version 8.0 where these

issues are not reported.

Minor font changes
As of Connect 2021.1 we no longer round fonts to pixel size. This can lead to tiny differences

in the output (of 1-2 pixels) when compared to earlier versions.

Changed Omit Master Page Back behaviour
In versions of Connect prior to 2020.2, if a page had no content except for a linked DataMap-

per background, then Connect would consider it an "empty" page when determining

whether or not to "Omit Master Page Back in case of an empty back page" (available as an

option in the sheet configuration of a section). This has now been fixed in Connect 2020.2,

and such pages are no longer considered empty.

This could impact on the output from existing templates.
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Print Wizard Preview showing some Landscape mode jobs in Portrait
mode
Print jobs featuring associated Connect Output Presets which have Imposition options set

to Landscape will not Preview in Landscape, but rather in Portrait mode. The printout is

unaffected, however.

Issues associating PDF files with Connect
Under certain circumstances, Connect Setups prior to 2019.2 would fail when attempting to

add the "Enhance with Connect" association with PDF files. This would then cause the setup

to appear to fail.

Whilst this issue has been fixed in the Connect 2019.2 installer, if a user had previously

experienced the issue and temporarily worked around it to complete the installation, then

the Connect installer will fail on upgrade or uninstallation.

To get around this, a manual uninstall is required, or a modification to registry entries.

Issues when loading some Workflow plugins for the first time
Under some circumstances, certain of the new Workflow plugins introduced with Connect

2019.2 will fail to load correctly when run for the first time. Instead of opening the plugin dia-

log as expected, the plugin hangs and displays a message that it is "Loading UI .... ". This is

due to an issue with a third party library which will be addressed in a future release.

To get around the problem, please close and reopen the plugin. The problem only occurs on

the initial opening, and should work fine thereafter.

The license update introduced in OL Connect 2019.1 does not cater for
existing AFP input licenses
AFP Input is an add on option for OL Connect licenses. Unfortunately, the update to the

2019.1 version of the OL Connect license does not cater for existing AFP input licenses.

If you have an existing AFP input license we ask that you contact your local Customer Care

team after the initial license update is complete and have them add the AFP input option

back into your license. (See (https://www.ob-

jectiflune.com/WebActivationManager/CareInfo.aspx.)

The Connect Print Manager is a standalone Connect tool that is used in production sites to

manage print jobs. It can be installed and run on standalone machines without a Connect

license.

The Update Client for Connect 2019.1 looks for a Connect license as part of the update
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process, but it will not find one on standalone Connect Print Manager installations. As a res-

ult the Update Client will not recognize that there is a Connect update available to the Print

Manager machine.

In order to update Connect Print Manager to version 2019.1 you will need to download the

Connect 2019.1 installer outside of the Update Client. The Connect 2019.1 installer can be

downloaded from the Web Activation Manager site. See https://www.ob-

jectiflune.com/webactivationmanager/. Or you could ask your local Administration for the

installer, as it would likely already have been downloaded for installation by the document

designers.

Page break changes in 2019.1
Improved page breaking in Connect 2019.1 might impact upon some existing templates.

It is recommended that you check page breaking in existing jobs, where page breaks at a

specific location are a known criteria.

Minor differences in AFP and IPDS output introduced in 2019.1
Connect 2019.1 now defaults to "Scale to Fit" for both IPDS and AFP output.

Please note that this may have an impact when printing pre-existing Connect jobs (made in

Connect versions predating 2019.1) on older printer models that do not support "Scale to

Fit".

Issue with image placement in 2019.1 when using some customized AFP
and IPDS Printer Definitions
An issue with image placement in Connect 2019.1 AFP and IPDS output was discovered just

prior to the release. The issue is specific to AFP and IPDS 600 DPI Printer Definitions that

are not set to "Scale to Fit".

As "Scale to Fit" is now switched on by default in all standard Connect 2019.1 AFP and IPDS

Printer Definitions, none of those should encounter the issue.

This issue will be fixed in a subsequent patch release.

Issue after erroneous or incomplete update or re-installation
If one or more products (the OL Connect Designer, Connect Server, Software Activation,

Print Manager, or Server Configuration Tool) or engines exit within a second of starting, this

may be caused by a recent erroneous or incomplete uninstall before a reinstall or upgrade

to a newer version of OL Connect.

This may be solved by deleting the %UserProfile%\Connect\.eclipse directory.

Page 110

https://www.objectiflune.com/webactivationmanager/


Backend database might require periodic maintenance
Databases maintain a variety of statistics in order to optimize performance. When high

levels of inserts and/or deletions occur, the statistical data keeping can struggle to keep up.

Over a period of prolonged and intensive processing this can result in a degradation in per-

formance, with the whole database slowing down as it struggles to clean itself up.

In Connect terms the effect can be felt as the Data Mapper and/or Job Creation pro-

gressively slowing down.

To cure this issue, it is recommended that you periodically run manual maintenance on the

backend database.

If using MySQL, the following script should be run in a query window:

set @a=null,@c=null,@b=concat("show tables where",

ifnull(concat(" `Tables_in_",database(),"` like '",@c,"' and"),''),

" (@a:=concat_ws(',',@a,`Tables_in_",database(),"`))");

Prepare `bd` from @b;

EXECUTE `bd`;

DEALLOCATE PREPARE `bd`;

set @a:=concat('optimize table ',@a);

PREPARE `sql` FROM @a;

EXECUTE `sql`;

DEALLOCATE PREPARE `sql`;

set @a=null,@b=null,@c=null;

If using Microsoft SQL Server run the following command in a query window:

sp_updatestats

Windows 10 Search service impacting Connect
The Windows 10 Search service runs as a background task, indexing files and folders. It has

been noted that this background task is sometimes preventing files being added to the Con-

nect temporary files folder when large amounts of files are being output and copied.

If this is an issue for you, we suggest disabling Search Indexing on the C:\User-

s\<username>\Connect folder.

This issue will be fixed in a later release.
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Job Presets: External Sorting change introduced in 2018.2
Versions prior to 2018.2 did not correctly save the line end characters for external sort con-

figurations in Job Presets, which meant the job could not be externally sorted. This issue

has been fixed in version 2018.2. However, Job Presets created with an earlier version may

still have the wrong line end character for external sorting. To fix this, open the Job Preset

in the new version, reset the line end setting in the sorting options and then save the preset.

Engine Preferences: Backward Compatibility Issues introduced in 2018.2
l Prior to version 2018.2 Connect allowed a mixture of internal and external engines. As

of OL Connect 2018.2 this is no longer allowed.

When upgrading to OL Connect 2018.2 from such installations, the pre-existing set-

tings will not only no longer apply, but can cause scheduling preference conflicts for

the Merge and Weaver engines.

To fix this, any pre-existing Connect installation that was running a mixture of

internal and external Merge and Weaver Engines must first restore their scheduling

preferences to the default values. This can be done by clicking on the Restore

Defaults button in the Scheduling pages of the Server Preference or the Designer

Preference dialogs.

l The Designer's scheduling settings are only updated correctly for the user actually per-

forming the update.

Business Graphics: Backward Compatibility Issues introduced in 2018.1
As a consequence of changes in both the user interface and the underlying technology,

Business Graphics made with a version prior to OL Connect 2018.1 may not display correctly

when opened in version 2023.2.

The currently known backward compatibility issues are listed here:

All charts
l Legend position: The position of the legend is not converted. It defaults to 'left' in a

converted chart.

l Rows are series/Columns are series: Only one type of data structure for detail tables

is supported in the new version: the one that corresponds to the former Columns are

series setting (with which charts display one series per record, one bar/point per data

field). After conversion to 2018.1, charts that used the Rows are series setting will be dis-

played as if the Columns are series setting were used. Pie charts will thus only show
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data from the first record in the detail table. If the number of records in the detail

table remains consistent, then the charts can be corrected by modifying the data

mapping configuration (see Preparing a data table in the Online Help: https://help.u-

plandsoftware.com/objectiflune/en/olconnect/2023.2/Home.html). Otherwise the data

needs to be transposed via script.

l NOTE: Expanded custom chart scripts cannot be converted.

Pie charts
l Default colors: The default colors (used when no pie chart colors are specified) have

changed.

Line and Bar charts
l Legend label: In previous versions, the name for a values series (needed for the

legend) could only be taken from a field outside the detail table. The value of the selec-

ted field would be used. Setting a different label required expanding the chart script.

After conversion, the name of the field is used instead of the value. Setting a different

label can now be done in the Edit Chart Script dialog (see Selecting data in a Business

Graphic script in the Online Help: https://help.uplandsoftware.com/objectiflune/en/ol-

connect/2023.2/Home.html).

Known Font issues
The following font(s) are known to have issues in OL Connect 2023.2:

l Benton Sans CFF font

Minor differences in PCL, AFP and IPDS output introduced in 2018.1
The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was

updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update could lead to increased output file sizes for some PCL, AFP and IPDS

jobs. This is generally not a cause for concern, however there might be some associated

increase in processing times, as well as some minor differences in the output. For example,

table line widths and font spacings might differ slightly (particularly for SMALL CAPS text),

which could lead to slightly different word-wrapping in some circumstances.

Windows Server 2016 issue
As of OL Connect 2018.1 Connect is officially supported under Windows Server 2016.

Please note, however, that the Update Client application might be blocked by the enhanced

security settings in Windows Server 2016.
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To fix this, add http://updates.ca.objectiflune.com to the list of trusted web sites on that

machine, or lower the internet access rules.

Limit of 100MB of image files within a single job
The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was

updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update also introduced a limit of 100MBs for image files included within a

single job. The limit is set at 100MB deliberately, as this allows most jobs to run faster.

However, if a job requires more than 100MBs of image files, then the Connect image cache

size can be increased to cater for such.

Please contact OL Support for instructions on how to modify the image memory cache

value, if needed.

Print Output: Booklet Impositioning changes introduced in 2018.1
When Booklet Impositioning is enabled, all pages within a document need to be changed to

duplex prior to Impositioning . The method for duplexing jobs has been changed to now

always combine existing pages into the front and backsides of sheets, rather than adding

empty backsides to any simplex pages.

The result is that now every document in the job becomes a booklet without any empty

pages between the first page and the last page.

With some exceptions. Booklet Impositionings that require a multiple of 4 pages (Saddle

binding and Perfect binding) will still get empty pages added, when needed.

Memory usage in clustered environments
If Database Petitioning is not selected, then OL Connect can fill the database faster than

the Clean-up service can clear it (the ratio is approximately 3:1), in high speed clustered

environments. Therefore if the system needs to run for some time under a considerable

load, a larger database should be used to prevent production from being interrupted. Or set

the clean-up service to use Database Partitioning.

We also recommend only the Master Server performing the database clean-up, or the local

Server Extension if the database is not installed with the Master, to maximize performance.

For all Designers, Server and Server Extensions except one, set the clean-up of the data-

base entities to run every 100 months and disable the clean-up for any Designer which also

has a Server or Server Extension on that machine.

Note that if the Designer is a stand-alone then it is not connected to the central database

for clean-up purposes.
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The Database Petitioning option can be found in the Clean-up Service preferences, see

https://help.uplandsoftware.com/objectiflune/en/olconnect/2023.2/Home.html in the Online

Help.

Issues with Microsoft Edge browser
The Microsoft Edge browser fails to display web pages when the Workflow's CORS option (in

the HTTP Server Input 2 section) is set to "*". This issue will be resolved in a future release.

Installation paths with multi-byte characters
When installing the Chinese (Traditional or Simplified) or Japanese versions of Connect, if

the user specifies an alternative installation path containing multi-byte/wide-char char-

acters it can break some of the links to the Connect-related shortcuts in the Start Menu

and cause an error to appear at the end of the installer. The workaround for the moment is

to use the default installation path. The problem will be addressed in a later release.

Switching languages
Changing the language using the Window > Preferences > Language Setting menu option

does not currently change all of the strings in the application to the selected language. This

is a known issue and will be fixed in a later release.

In the meantime we offer the following workaround for anyone who needs to change the lan-

guage:

1. Go to the .ini files for the Designer and Server Config:

l C:\Program Files\Objectif Lune\OL Connect\Connect Design-

er\Designer.ini

l C:\Program Files\Objectif Lune\OL Connect\Connect Server Con-

figuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es |

de | fr | it | ja | ko | pt | tw | zh

Only one of the above language tags should be selected. Once saved, Connect will appear

in the selected language at next start-up.

GoDaddy certificates
When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most

users should use the default settings and click Next. In some cases, however, this may not

work correctly. For this reason those users should activate Place all certificates in the fol-

lowing store and then select the Trusted Root Certification Authorities as the target cer-

tificate store.
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MySQL Compatibility
The minimum supported MySQL version is MySQL 5.6.

PostScript print presets
The print presets for PostScript were changed from Version 1.1 onwards meaning that some

presets created in Version 1.0 or 1.0.1 may no longer work.

Any PostScript print preset from Version 1.0 that contains the following will not work in Ver-

sion 2023.2: *.all[0].*

Any preset containing this code will need to be recreated in Version 2023.2.

Available Printer Models
Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of

the Print Wizard by default.

To add additional printer models click on the settings button next to the Model selection

entry box.

External resources in Connect
There are certain limitations on how external resources can be used in Connect. For

example if you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the

network but you do not want to have a copy of the file saved with the template you need to

do the following:

1. The resource must be located where it can be accessed by all Servers/Slaves run as

users. Failure to do this will cause the image to appear as a Red X in the output for all

documents which were merged by engines which could not access the file. The job will

terminate normally and the error will be logged.

2. The file must be referenced via a UNC path e.g.,

file://///w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg

l UNC paths are required because the services will be unable to access mapped

network drives (Windows security feature).

l The engine processing the job will look on the local file system for the direct file

path leading to the “resource not found” issue mentioned above.

Caution: The Designer itself and Proof Print do not use processes that run as services

and they may find local files with non-UNC paths which can lead to the false impres-

sion that the resources are correct.
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Using Capture after installing Workflow 8
If OL Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, Capture can

no longer be used within Workflow 7. The plugins are now registered uniquely to Workflow 8

and the Messenger for Workflow 7 is taken offline. It is only possible to use Capture from OL

Connect Workflow 8 thereafter.

Capturing spool files after installing Workflow 8
If OL Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, the Plan-

etPress Suite 7 option to capture spool files from printer queues will no longer function. The

solution is to use OL Connect Workflow 8 to capture spool files from printer queues.

Color Model in Style Sheets
The color model of colors defined in a style sheet can sometimes change after editing the

style sheet. This is a known issue and will be addressed in a subsequent release.

Image preview in Designer
If in the Windows Internet settings (Connection Settings > LAN configuration) a proxy is

enabled, but "Bypass proxy settings for local addresses" is not checked, the image preview

service, conversion service and live preview tab in the Designer will not work and exhibit the

following issues:

l Images will be shown as 0 size boxes (no red 'X' is displayed).

l Live preview does not progress, and when re-activated reports "browsers is busy".

To fix the issue you must check the "Bypass proxy settings for local addresses" option.

Merge/Weaver engines when printing
The print operation in the Designer will automatically detect whether the Merge\Weaver

engines are available and display a message for the user to retry or cancel if not. Once the

Merge/Weaver engine becomes available and the user presses retry the print operation will

proceed as normal. This message can also occur in the following circumstances:

l If the server is offline and you are not using Proof Print.

l On some occasions before the Print Wizard opens.

REST Calls for Remote Services
The Server will accept REST calls for all remote services and will make commands wait

indefinitely until the required engines become available. The Server will log when it is wait-

ing for an engine and when it becomes available. Note that there is no way to cancel any

commands other than stopping the Server.
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Print Content and Email Content in OL Connect Workflow
In OL Connect Workflow’s Print Content and Email Content tasks, the option to Update

Records from Metadata will only work for fields whose data type is set to String in the data

model. Fields of other types will not be updated in the database and no error will be raised.

This will be fixed in a later release.

Print Limitations when the Output Server is located on a different
machine
The following limitation may occur when using the Print options from a Designer located on

a different machine to the Output Server:

l The file path for the prompt and directory output modes is evaluated on both the cli-

ent AND server side. When printing to a network share it must be available to BOTH

the Designer and Server for the job to terminate successfully.

l The Windows printer must be installed on both the Server and Designer machines.

l When printing via the Server from a remote Designer, the output file remains on the

Server machine. This is remedied by selecting “Output Local” in the Output Creation

configuration.

VIPP Output
Some templates set up with landscape orientation are being produced as portrait in VIPP. It

can also sometimes be the case that text and images can be slightly displaced. These are

known issues and will be addressed in a later release of Connect.

Magic Number changes when installing Docker
Installing Docker on a system where Connect has already been installed may impact Con-

nect's licensing mechanism and require reactivation.

Note: Installing Connect after Docker has already been installed will not cause issues.
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Uninstalling
This topic provides some important information about uninstalling (removing) OL Connect

2023.2.

To uninstall OL Connect select the application from within the Add/Remove programs

option under the Control Panel. This will start the OL Connect Setup Wizard in uninstall

mode.

Note: The OL Connect Setup Wizard might take some seconds to appear.

Important: Stop any active Anti-Virus software before uninstalling Con-
nect back-end database.
Some anti-virus systems are known to block the uninstallation of MariaDB datafiles, as well

as blocking the uninstallation of the MariaDB database application itself. If you wish to unin-

stall the Connect back-end database it is highly recommended that any anti-virus applic-

ation be stopped prior to uninstalling OL Connect , as otherwise the Connect uninstallation

might not work correctly.

Impacts upon other applications and services
l The Uninstall will terminate the installed Server / MariaDB service(s).

l The following applications / services should be stopped in a controlled fashion, before

running the OL Connect Uninstall:

1. OL Connect

2. Connect products on remote systems which refer to this MariaDB database.

3. Any Connect Workflow using OL Connect plugins which connect to this server.

4. OL Connect Server Extensions (Enterprise edition only) on remote systems which

connect to this machine as the Master Server.

Uninstallation Wizard
The uninstallation is done by running the OL Connect Setup Wizard in uninstall mode. The

Wizard contains the following important pages:

1. OL Connect Setup: This page allows selection of what is to be done. An modification to

the existing installation (Add or Remove Features) or full Uninstall.

NOTE: If the Uninstall option is selected the Remove user data option is made avail-

able. For information about exactly what data would be saved or deleted, please see

"Pre-existing User Data" on page 57.

Page 119



2. Component Selection: If Add or Remove Features was selected on previous screen,

this page provides options for adding or removing Connect features.

For detail descriptions of the options, see Installation "Component Selection" on

page 26 .
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Legal Notices and Acknowledgments
Warning: OL Connect is protected by copyright law and international treaties. Unauthorized

reproduction or distribution of this program, via any means, in part or in whole, may be pro-

secuted to the full extent of the law.

The license agreements for the associated open source third party components can be

found in the following installation folder: C:\Program Files\Objectif Lune\OL Connect\Legal

Notices

This application uses the following third party components:

l Adobe PDF Library which is either a registered trademark or trademark of Adobe Sys-

tems Incorporated in the United States and\or other countries.

l Adobe XMP Core Copyright © 1999 - 2010, Adobe Systems Incorporated. All rights

reserved.

l ​ASM librares which are distributed under a BSD 3-clause License

l Bouncy Castle which is distributed under an MIT license (MIT License)

l c3p0 which is licensed under the terms of the Lesser General Public License

(LGPL) Version 2.1. The source code can be obtained from the following location:

https://github.com/swaldman/c3p0

l DD Plist which is distributed under an MIT license (MIT License)

l Eclipse Gemini Blueprint which is distributed under the terms of the Apache Software

License Version 2.0. This product includes sub-components with separate copyright

notices and license terms.

l Eclipse Nebula This application also uses the following Eclipse Nebula components

which are distributed under the terms of the Eclipse Public License (EPL) v 2.0 :

l Radiogroup Widgets

l Eclipse Persistence Services Project (EclipseLink), Copyright © 2007, Eclipse Found-

ation, Inc. and its licensors. All rights reserved. This is distributed under the terms of

the Eclipse Public License Version 1.0 and Eclipse Distribution License Version 1.0.

l Fugue Icons by Yusuke Kamiyamane which are distributed under the terms of the

Creative Commons Attribution 3.0 License.

l Gecko which is distributed under the terms of the Mozilla Public License (MPL) Version

2.0. Information on obtaining Gecko can be found on the following page: https://wiki.-

mozilla.org/Gecko:Getting_Started
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NOTE: This library has been modified for Connect. To obtain copies of the modified lib-

rary please contact your local Objective Lune Support team.

l ​​Glassfish This application also uses the following Glassfish components which are dis-

tributed under the terms of the Eclipse Public License (EPL) v 2.0 :

l HK2 API module

l HK2 Implementation Utilities

l Javax Inject

l Jersey

l Jersey Bean Validation

l Jersey Container Jetty HTTP

l Jersey Container Servlet

l Jersey Container Servlet Core

l OSGi Resource Locator

l ServiceLocator Default Implementation

Information on how to download the Glassfish project sources can be obtained from

here: https://mvnrepository.com/search?q=org.glassfish

l Glassfish Java Mail which is licensed under the terms of the Common Development

and Distribution License (CDDL) Version 1.0. Information on how to download the

Glassfish source can be obtained from here: https://wi-

kis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates

l ​Google Core Protocol Buffers library which is distributed under a BSD 3-clause

License

l Hamcrest Matchers Copyright © 2000-2006, www.hamcrest.org. All rights reserved.

l HyperSQL, Copyright © 2001-2010, The HSQL Development Group. All rights reserved.

l IcoMoon. Connect uses unmodified icons from IcoMoon (https://icomoon.io/#icons-ico-

moon) which have been made available under the Creative Commons By 4.0 license

(https://creativecommons.org/licenses/by/4.0).

l ICU4J 4.4.2 Copyright © 1995-2013 International Business Machines Corporation and

others. All rights reserved.
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l J2V8 which is distributed under the terms of the Eclipse Public License (EPL) Version

1.0. The source code for J2V8 can be obtained from the following location: https://-

github.com/eclipsesource/j2v8

l Jacob Java Com Bridge which is licensed under the terms of the GNU Lesser General

Public License (LGPL) Version 2. The source code for this can be obtained from the fol-

lowing location: http://sourceforge.net/projects/jacob-project/files/jacob-project/

l ​Java Advanced Imaging Image I/O Tools which is distributed under a BSD 2-clause

License (BSD-2-Clause license)

l JavaSysMon Copyright © 2009 ThoughtWorks, Inc. All rights reserved.

l Java XmlHttpRequest which is licensed under the terms of the GNU Lesser General

Public License Version (LGPL) 2.1. The source code for this can be obtained from the

following location: https://github.com/objectifluneCA/java-XmlHttpRequest

l ​JavaX EJB API which is distributed under the terms of the Common Development and

Distribution License (CDDL) Version 1.0. The source code for this can be obtained from

the following location: https://mvnrepository.com/artifact/javax.ejb/javax.ejb-api/3.2.2

l ​JavaX Expression Language which is distributed under the terms of the Common

Development and Distribution License (CDDL) Version 1.0. The source code for this can

be obtained from the following location: https://m-

vnrepository.com/artifact/org.glassfish/javax.el

l ​JavaX interceptor API which is distributed under the terms of the Common Devel-

opment and Distribution License (CDDL) Version 1.0. The source code for this can be

obtained from the following location: https://m-

vnrepository.com/artifact/javax.interceptor/javax.interceptor-api/1.2.2

l ​JavaX Mail which is distributed under the terms of the Common Development and Dis-

tribution License (CDDL) Version 1.1. The source code for this can be obtained from the

following location: https://java.net/projects/javamail/downloads/directory/source

l ​JavaX Management J2EE API which is distributed under the terms of the Common

Development and Distribution License (CDDL) Version 1.0. The source code for this can

be obtained from the following location: https://m-

vnrepository.com/artifact/javax.management.j2ee/javax.management.j2ee-api/1.1.2

l JavaX Resource API which is distributed under the terms of the Common Devel-

opment and Distribution License (CDDL) Version 1.0. The source code for this can be

obtained from the following location: https://m-

vnrepository.com/artifact/javax.resource/javax.resource-api/1.7.1
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l ​JavaX Servlet API which is distributed under the terms of the Common Development

and Distribution License (CDDL) Version 1.0. The source code for this can be obtained

from the following location: https://m-

vnrepository.com/artifact/javax.servlet/javax.servlet-api/3.1.0

l ​JavaX Transaction API which is distributed under the terms of the Common Devel-

opment and Distribution License (CDDL) Version 1.0. The source code for this can be

obtained from the following location: https://m-

vnrepository.com/artifact/javax.transaction/javax.transaction-api/1.3

l ​JavaX WS RS API which is distributed under the terms of the Eclipse Public License v

2.0 (EPL2). The source code for this can be obtained from the following location:

https://mvnrepository.com/artifact/javax.ws.rs/javax.ws.rs-api/2.1.1

l Jaxb API which is licensed under the terms of the Common Development and Dis-

tribution License (CDDL) Version 1.1. The source code can be found at the following loc-

ation: https://mvnrepository.com/artifact/javax.xml.bind/jaxb-api

l Jaxb OSGI which is licensed under the terms of the Common Development and Dis-

tribution License (CDDL) Version 1.1. The source code can be found at the following loc-

ation:

https://bit-

bucket.org/uplandsoftware/vendor/src/master/java/github.com/javaee/jaxb-v2/

l ​JBCrypt library which is distributed under the ISC License (ISC)

l Jersey which is distributed under the terms of the Common Development and Dis-

tribution License (CDDL) Version 1.1. Information on how to obtain the source code can

be found at the following location: http://repo1.maven.or-

g/maven2/org/glassfish/jersey/jersey-bom

l jersey-json-1.13 which is licensed under the terms of the Common Development and

Distribution License (CDDL) Version 1.1. Information on how to obtain the source code

can be found at the following location: http://m-

vnrepository.com/artifact/com.sun.jersey/jersey-json/1.13-b01

l Jersey Multipart which is distributed under the terms of the Common Development

and Distribution License (CDDL) Version 1.1. Information on how to obtain the source

code can be found at the following location: http://repo1.maven.or-

g/maven2/org/glassfish/jersey/jersey-bom

l JNA Version 3.5.1 which is distributed under the terms of the GNU Lesser General

Public License Version (LGPL) 2.1. The source code for this can be obtained from the

following location: https://github.com/twall/jna/releases
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l jQuery library which is distributed under an MIT license (https://jquery.org/license/).

l jQuery validation library which is distributed under an MIT license (JQuery Validation

licence).

l Logback which is distributed under the terms of the Eclipse Public License

(EPL) Version 1.0. The source code for Logback can be obtained from the following loc-

ation: https://logback.qos.ch/download.html

l MariaDB which is distributed under the terms of the GNU General Public License Ver-

sion 2. Information on how to obtain the source code can be found at the following loc-

ation: https://mariadb.org/get-involved/getting-started-for-developers/get-code-

build-test/

l MariaDB Java Client which is distributed under the terms of the GNU Lesser General

Public License Version (LGPL) 2.1. The source code for this can be obtained from the

following location: https://mvnrepository.com/artifact/org.mariadb.jdbc/mariadb-

java-client

l Mchange Commons Java which is licensed under the terms of the Lesser General

Public License (LGPL) Version 2.1. The source code can be obtained from the following

location: https://mvnrepository.com/artifact/com.mchange/mchange-commons-java

l Minimatch Java which is distributed under an MIT license (MIT License).

l Objectweb ASM, Copyright © 2000-2011 INRIA, France Telecom. All rights reserved.

l Oracle JDBC Driver which is licensed by the Oracle Free Use Terms and Conditions

(FUTC) licence.

l org.eclipse.equinox.weaving.springweaver which is distributed under the terms of the

Eclipse Public License (EPL) Version 1.0. The source code can be obtained from the fol-

lowing location: https://github.com/osgi-forks/dynaresume

l PDF Renderer which is licensed under the terms of the Lesser General Public License

(LGPL) Version 2.1. The source code can be obtained from the following location:

https://mvnrepository.com/artifact/pdf-renderer/pdf-renderer

l Polyfills which is licensed under the Unlicense license. The source code can be

obtained from the following location: https://github.com/inexorabletash/polyfill.

l RapidJSON which is distributed under an MIT license.

l Relique CSV Driver which is licensed under the terms of the Lesser General Public

License (LGPL) Version 2.1. The source code can be obtained from the following loc-

ation: https://sourceforge.net/p/csvjdbc/code/ci/csvjdbc-1.0.31/tree/

Page 125

https://jquery.org/license/
https://github.com/jquery-validation/jquery-validation/blob/master/LICENSE.md
https://github.com/jquery-validation/jquery-validation/blob/master/LICENSE.md
https://logback.qos.ch/download.html
https://mariadb.org/get-involved/getting-started-for-developers/get-code-build-test/
https://mariadb.org/get-involved/getting-started-for-developers/get-code-build-test/
https://mvnrepository.com/artifact/org.mariadb.jdbc/mariadb-java-client
https://mvnrepository.com/artifact/org.mariadb.jdbc/mariadb-java-client
https://mvnrepository.com/artifact/com.mchange/mchange-commons-java
https://opensource.org/licenses/mit-license.php
https://github.com/osgi-forks/dynaresume
https://mvnrepository.com/artifact/pdf-renderer/pdf-renderer
https://unlicense.org/
https://github.com/inexorabletash/polyfill
https://sourceforge.net/p/csvjdbc/code/ci/csvjdbc-1.0.31/tree/


l Rhino 1.7R4 and 1.7.7.1 which are licensed under the terms of the Mozilla Public License

(MPL) Version 2.0. The source code for these can be obtained from the following loc-

ation: https://developer.mozilla.org/en-US/docs/Mozilla/Projects/Rhino/Download_

Rhino

l Saxon which is distributed under the terms of the Mozilla Public License (MPL) Version

2.0. The source code for this can be obtained from the following location: http://-

sourceforge.net/projects/saxon/files/Saxon-HE/9.6/

l Servlet API developed by Sun as part of the Glassfish project and licensed under the

terms of the Common Development and Distribution License (CDDL) Version 1.0.

Information on how to download the Glassfish source (as part of Java EE platform)

can be obtained from here: https://wi-

kis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates

l Simple Logging Facade for Java (SLF4J) Copyright © 2004-2017 QOS.ch. All rights

reserved.

l SpotBugs Annotations which is licensed under the terms of the GNU Lesser General

Public License (LGPL) Version 2.1. The source code for this can be obtained from the

following location: https://github.com/spotbugs/spotbugs

l Spring Framework which is distributed under the terms of the Apache Software

License Version 2.0. This product includes sub-components with separate copyright

notices and license terms.

l StAX Utilities Copyright © 2007, StAX Utilities Project. All rights reserved.

l Stax2 API Copyright 2010-2018 FasterXML.com.

l Tern which is distributed under the terms of the Eclipse Public License (EPL) Version

1.0. The source code for tern can be obtained from the following location: https://-

github.com/angelozerr/tern.java

l Web Services Description Language for Java which is distributed under the terms of

the Common Public License v 1.0. The source code for this can be obtained from the

following location: http://wsdl4j.cvs.sourceforge.net/viewvc/wsdl4j/

l ​XStream Core library which is distributed under a BSD 3-clause License

l XULRunner which is distributed under the terms of the Mozilla Public License Version

2.0. The source code for this can be obtained from the following location: http://ft-

p.mozilla.org/pub/mozilla.org/xulrunner/releases/latest/source/

Page 126

https://developer.mozilla.org/en-US/docs/Mozilla/Projects/Rhino/Download_Rhino
https://developer.mozilla.org/en-US/docs/Mozilla/Projects/Rhino/Download_Rhino
http://sourceforge.net/projects/saxon/files/Saxon-HE/9.6/
http://sourceforge.net/projects/saxon/files/Saxon-HE/9.6/
https://wikis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates
https://wikis.oracle.com/display/GlassFish/Java+EE+7+Maven+Coordinates
https://github.com/spotbugs/spotbugs
https://github.com/angelozerr/tern.java
https://github.com/angelozerr/tern.java
http://wsdl4j.cvs.sourceforge.net/viewvc/wsdl4j/
http://ftp.mozilla.org/pub/mozilla.org/xulrunner/releases/latest/source/
http://ftp.mozilla.org/pub/mozilla.org/xulrunner/releases/latest/source/


l zziplib which is licensed under the terms of the Mozilla Public License (MPL) Version

1.1. The source code for this can be obtained from the following location: http://-

sourceforge.net/projects/zziplib/files/zziplib13/

Portions of certain libraries included in this application which are distributed under the

terms of the Mozilla Public License have been modified. To obtain copies of the modified lib-

raries please contact your local Objective Lune Support team.

Apache Software License Components
This application also uses the following components which are distributed under the terms

of the Apache Software License Version 2.0:

l Apache ActiveMQ

l Apache Aries

l Apache Batik

l Apache Commons Beanutils

l Apache Commons CLI

l Apache Commons Codec

l Apache Commons Collections

l Apache Commons Compress

l Apache Commons DBCP

l Apache Commons Digester

l Apache Commons Imaging

l Apache Commons IO

l Apache Commons JCS Core

l Apache Commons Lang

l Apache Commons Logging

l Apache Commons Math

l Apache Commons Pool

l Apache Commons Text

l Apache Commons Validator

l Apache Felix and dependencies

l Apache Geronimo
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l Apache HttpClient

l Apache HttpClient Mime

l Apache HttpClient Windows features

l Apache HttpComponents Core HTTP/1.1

l Apache HttpComponents Core HTTP/2

l Apache HttpCore

l Apache Log4j API

l Apache Log4j to SLF4J

l Apache POI

l Apache ServiceMix

l Apache Tika Core

l Apache Tika Standard Parser

l Apache ​Xerces2 Java Parser

l Apache XML Graphics

l Apache XML Beans

l ASN1bean

l Barcode4j

l Google Collections

l Google GSON

l Hibernate Validator

l Jackcess

l Jackson JSON processor

l JCIP Annotations

l JDBI

l JetBrains Java Annotations

l Jetty

l Jetty alpn client

l Jetty webapp

l Jetty Websocket API
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l Jetty Websocket Core

l JSON Path

l JSON Sanitizer

l JSON Small and Fast Parser

l Kotlin Common Standard Library

l Kotlin Standard Library for JVM

l Liquibase

l LMAX Disruptor

l Minidev

l Nimbus JOSE+JWT

l Objenesis

l OkHttp

l OkIO

l OpenCSV

l OpenTelemetry for Java

l OpenTelemetry Instrumentation for Java

l OPS4J Pax Web

l org.eclipse.persistence.logging.slf4j

l org.json.simple

l OSGI

l PAC4J

l Quartz Scheduler

l Sisyphsu DateParser

l Sisyphsu Retree

l Snakeyaml

l SNMP4J

l ​Spring Dynamic Modules

l Swagger

l Tika
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l ​UCanAccess

l Woodstox

l xalan

l XML Resolver

Eclipse Technology:
This Software includes unmodified Eclipse re-distributables, which are available at www.e-

clipse.org. The Eclipse re-distributables are distributed under the terms of the Eclipse

Public License - v 1.0 that can be found at https://www.eclipse.org/legal/epl-v10.html.

Eclipse Adoptium OpenJDK

This application uses unmodified re-distributables from the Eclipse Adoptium OpenJDK pro-

ject. The Licenses used in that project are:

l Build scripts and other code to produce the binaries, the website and other build infra-

structure are licensed under Apache License, Version 2.0.

l OpenJDK code itself is licensed under GPL v2 with Classpath Exception (GPLv2+CE).

l Eclipse OpenJ9 is licensed under Several licenses.

Further Components:
l Portions of this software are copyright © 2018 The FreeType Project

(www.freetype.org). All rights reserved.

l This product includes software developed by JSON.org (https://www.json.org), which is

distributed under the JSON License (JSON License)

l This product includes software developed by the Indiana University Extreme! Lab. For

further information please visit http://www.extreme.indiana.edu/
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